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Introduction 
R.N. Elliott developed Elliott Wave Theory in the 1920’s. Mr. Elliott 
discovered there is no chaos in the markets, but on the contrary this is a 
natural order in the markets that manifests it self in wave patterns, which 
continually repeat themselves. These wave patterns continually repeat 
themselves over and over again in the markets. The wave patterns are also 
fractal in nature, which means that you can subdivide these waves into 
smaller and smaller waves and they was have the same pattern, just a 
different degree. 
In the 1970’s the Elliott Wave Principal was extremely popular because of 
books published by Prechter and Frost. The most famous book they 
published was “The Elliott Wave Principle…key to stock market profits” in 
1978. Robert Prechter was extremely popular and was frequently 
interviewed by the news media during the time. He predicted the bull 
market of the time and even the crash of 1987.  
The secret of the Elliott Wave Theory is to learn how to correctly detect 
these wave patterns that tend to occur over and over again in the markets. 
These wave patterns can be divided into basically two kinds, the trending 
wave and the non-trending wave. Some people call them impulse waves 
and corrective waves. The markets tend to trend only 20% of the time and 
they go into corrections 80% of the time.  
The impulse wave has five price movements. Three of them are in the 
direction of the market and two of them are in the opposite direction of the 
market. See Fig. 1. 

Fig. 1 
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These five waves can also be broken down into smaller waves. Each 
impulse wave has five waves and each correction has 3 waves. See Fig. 2. 

Fig. 2 
The corrective waves can also be broken down into a smaller degree. 
Waves A and C are in the direction of the reaction. This would illustrate the 
reaction in a bullish trend. See Fig. 3. 

Fig. 3 
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It should be very easy now to distinguish between the trends of the market 
and the corrections. See Fig 4. Also it’s important to understand the 
concept that the wave structure of the large degree is composed of the 
same wave structure in the smaller degree. 
 

 

Fig. 4 
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The following are the wave degrees the most Elliott Wave Technicians 
follow: 

 
 
You must remember that the possible number of wave degrees is infinite. 
You can only trade so many waves down. The smallest detectable wave 
pattern would be using a 1 minute bar chart. The advantage of having 
different degrees of waves is that you can trade the degree that you are 
most comfortable with. Day-traders might trade the Sub Minuette Wave 
Degree and intermediate investors might use the Primary Wave Degree to 
trade. 
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Patterns 
Recognizing the patterns of the waves as they are developing is the most 
important thing you can do. Many Elliott Wave technicians can correctly 
analyze a completed chart with the correct patterns, but what good does 
that do. You need to do it as it is happening. You can correctly determine 
the where you are in the Elliott Wave pattern, as it is unfolding, it will tell 
you the levels the market will rise or fall to. That’s the importance of the 
Elliott Wave theory. 
The unique software ELWAVE gives you the Elliott Wave patterns 
automatically so you can better trade the markets. 

Classic Patterns vs. Modern Elliott Wave Patterns 
There are two versions of the Elliott Wave Theory. One is the classic 
version brought out by Elliott and the modern version that Prognosis 
Software Development found after 10 years of research and experience. 
You will have to experiment which each of the markets to determine which 
set of patterns to use. The ELWAVE software program makes it easy to do. 
You can select which to use with just a click of the mouse button. 
Now let’s look at the various Elliott Wave Patterns in a very strict manner 
according to the rules followed by Elliott Wave technicians: 
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Trends 
a. Impulse 

 
Pattern 

 
 
Fig. 5 

Description 
Impulse waves are composed of five waves labeled 1,2,3,4,5. 
Waves 1, 3, 5 are themselves impulse waves. 
Waves 1, 3, 5 are usually equal in length. 
Waves 2 and 4 are corrective waves. 

Rules and Guidelines 
Wave 2 cannot be longer in price than wave 1. 
It can’t go beyond the origin of wave 1. 
Wave 3 is never the shortest when compared to waves 1 and 5. 
Wave 4 cannot overlap wave 1. Exception, diagonal triangles. 
The third wave usually shows the highest momentum. 
Exception, when the fifth wave is the extended wave. 
 
In Which Wave 
Impulse patterns occur in wave 1, 3, 5 and waves A and C 
 
Internal Structure 
Composed of five waves 5-3-5-3-5 
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Trends 
b. Extension 

Pattern 
 

 

Fig. 6 
Description 
An extension occurs in a impulse wave. 
It can be wave 1, 3, or 5 
Usually one of these waves is extended. 
Normally the third wave is the extended wave. 
The other two waves are normally equal in length. 
 
Rules 
Extended waves are composed of 5, 9, 13 or 17 waves. 
Wave 2 can’t be long in  price distance than wave 1. 
Wave 3 is never the shortest when compared to wave 1 and 5. 
Wave 4 can’t overlap wave 1. 
Wave 5 exceeds the end of wave 3. 
The extended wave normally shows the highest acceleration. 
 
In Which Wave 
Extensions occur in wave 1, 3, 5 and in A and C waves. 
 

Internal Structure 
Minimum number of waves of an extended wave is 9, 13 or 17. 
Minimum internal structure of 9 waves is 5-3-5-3-5-3-5-3-5. 
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Trends 
c. Diagonal Triangle Type 1 

Pattern 
 

 
 
Fig. 7 
 
Description 
Diagonals are impulse patterns. 
They occur in terminal waves like fifth or a C wave. 
Diagonals are relatively rare. 
They occur a lot in lower wave degree charts. 
Usually they are followed by a violent change. 
Rules and Guidelines 
It is composed of 5 waves. 
Waves 4 and 1 do overlap. 
Wave 4 can’t go beyond the origin of wave 3. 
Wave 3 can’t be the shortest wave. 
Internally all waves of the diagonal have a corrective structure. 
Wave 1 is the longest wave and wave 5 the shortest. 
The Channel lines of Diagonals must converge 
The internal wave structure should show alternation. 
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In Which Wave 
Diagonal triangles type 2 occur in waves 1 and A. 

Internal Structure 
The five waves of the diagonal type 2 show an internal structure of 5-3-5-3-
5. 

Trends 
d. Failure or Truncated 5th 

Pattern 

 
Fig. 8 
 
Description 
Impulse wave in which the fifth doesn’t extend beyond the third. 
Fifth wave goes only slightly beyond the third wave. 
Classified as a failure wave. 
 
Trend is week and will accelerate in opposite direction. 

 
Rules and Guidelines 
Wave 2 can’t be longer in price than wave 1. 
Wave 2 can’t go beyond the origin of wave1. 
Wave 4 can’t overlap wave 1 or A. 
Wave 5 fails to go beyond the end of wave 3. 
Wave 3 shows the highest momentum. 
Internal wave structure should show alternation. 
 
Internal Structure 
It must be composed of five waves. 
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Corrections 
a. Zigzag 

Pattern 

 

Fig. 9 
 
Description 
The most common corrective wave structure. 
Begins with a sharp reversal. 
It looks like an impulsive wave 
Can extend into a double or triple zigzag. (not common) 
 
Rules and Guidelines 
Composed of 3 waves 
Wave A and C are impulses, Wave B is corrective. 
The B wave retraces no more than 61.8% of A 
The C wave must go beyond the end of A 
The C wave normally is at least equal to A 
 
In Which Wave 
Most of time it happens in A, X or 2. 
Also common in B waves or part of a Flat or Triangles or in 4. 

Internal Structure 
Internal structure of the 3 waves is 5-3-5 in a single Zigzag, 5-3-5-3-5-3-5 in 
a double. 
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Corrections 
        Example of a Double Zigzag 
 

 

Fig. 10 
 
The above is a modern representation of the Double Zigzag using the 
labels WXY instead of ABCXABC.  This is more consistent because this 
way 2 zigzags of lower degree get corrected to each other by waves of 
higher degree. 
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Corrections 
b. Flat 

Pattern 

 
Fig. 11 

Description 
Flats are very common form of correction patterns. 
Shows sideways direction. 
Waves A and B of the Flat are both corrective patterns. 
Wave C is an impulse pattern. 
Normally eave C will not go far beyond the end of wave A. 
 
Rules and Guidelines 
It is composed of 3 waves. 
Wave C is an impulse, Wave A and B are corrective. 
Wave B retraces more than 61.8% of A 
Wave B shows a common retracement to the end of previous wave. 
Wave C shouldn’t go far beyond the end of A 
Normally wave C is at least equal to A. 
 
In Which Wave 
It occurs mostly in B waves, also common in 4 and 2. 

Internal Structure 
The internal structure of these waves is 3-3-5. Both waves A and B are 
normally Zigzags. 
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Corrections 
c. Expanded Flat or Irregular Flat 

 
Fig. 12 

Description 
This is a common special type of a Flat. 
B wave is extended and goes beyond the end of the previous wave. 
The B wave has a lot of strength and shows the direction of B. 
Strong acceleration is present which starts the 3rd or 5th wave. 
If C wave is much longer than A, the strength will be less. 
 
Rules and Guidelines 
It is composed of 3 waves. 
Wave C is an impulse, wave A and B are corrective. 
Wave B retraces beyond the end of the previous impulse wave A. 
The C wave normally is much longer than A. 
 
In Which Wave 
Can happen in 2, 4, B and X. It can happen in 2 and C is relatively short, 
normally an acceleration in the third will take place. 

Internal Structure 
Composed of five waves, which has a structure of 3-3-5-5. 
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Corrections 
d. Triangles (Contracting) 

Pattern 

 
Fig. 13 

Description 
A triangle is a corrective pattern, which can contract or expand. 
It can ascend or descent. 
It is composed of five waves; each of them has a corrective nature. 
Rules and Guidelines 
It is composed of 5 waves. 
Wave 4 and 1 do not overlap. 
Wave 4 can’t go beyond the origin of wave 3 
Internally all waves have a corrective wave structure. 
Wave 1 is the longest wave and wave 5 is the shortest. 
 
In Which Wave 
Triangles occur in wave B, X and 4, never in wave 2 or A. 

Internal Structure 
It is composed of fives waves, internal structure 3-3-3-3-3. 
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Corrections 
     Expanding Triangle 

Pattern 

 
Fig. 14 
 
Ascending Triangle 
This triangle slopes upwards. 
This pattern has been implements in Modern Rules. 
 

Descending Triangle 
This is a triangle, which slopes downwards. 
This pattern has been implemented in modern rules. 
Running Triangle 
This is a triangle where the B wave exceeds the origin of wave A. 
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Corrections 
e. WXY or Combination 

 
Pattern 

 
Fig. 15 

Description 
Combines several types of corrections. 
Labeled WXY and WXYXZ. 
 
Rules and Guidelines 
Forms small patterns to make a larger one. 
The triangle should normally appear at the end. 
 

In Which Way 
Generally a combination occurs mostly in B, X and 4. 
Less common in A and rare in 2. 

Internal Structure 
A Zigzag followed by a flat, followed by a Triangle has the following internal 
structure. 5-3-5 (Zigzag)-5-3-3-5 
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Corrections 
f. Running Flat 

Pattern 

 
Fig. 16 
 
Description 
Rare form of a failure. 
Kind of a Flat with elongated B wave and very small C wave. 
ELWAVE doesn’t accept a C wave that fails to reach wave A. 
This could be an extension in an impulse wave. 
If B is a clear three wave, then it is a running correction. 
The market will explode in the direction of the B wave. 
 
Rules and Guidelines 
The B wave must be composed of three waves. 
The C wave must be composed of five waves. 
Wave C must be very short and not reach wave A. 
Wave C must retrace less than 100% of wave B. 
Wave C must retrace more than 60% of wave A. 
 
In Which Wave 
Most of the time it should occur in wave 2 or B. 
 
Internal Structure 
It is a three-wave structure 3-3-5. 
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Modern Elliott Wave Patterns 
In the Modern Rules ELWAVE engine the program has defined extra 
pattern that are mostly hybrid patterns derived from the known patterns that 
have existed from the beginning. In addition the program allows for 
occurrence of more patterns in some wave. For example, wave 1 may also 
contain a diagonal 1, diagonal 2 and impulse 2 pattern, next to the other 
trend patterns, that a classic interpretation accepts. 
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Trends 
a. Impulse 2 

 
Fig. 17 

Description 
An impulse 2 is an uncommon pattern. 
ELWAVE allows for a maximum retrace of 51.5% for wave 4. 
Sometimes the retrace of wave 4 could be 51.6%. 
 

Rules and Guidelines 
The same rules and guidelines apply as with a normal impulse except for 
the following: 
Wave 4 is allowed to retrace in between 51.5% and 62%. 
Must not penetrate the region of wave 1. 
As a guideline, wave 4 very often is a Zigzag. 
 
In Which Wave 
Impulse 2 patterns occur in wave 1, A or C, never in wave 3. 
Internal Structure 
It is composed of five waves 5-3-5-3-5. 
The mentioned 3’s are corrective waves. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

22

Corrections 
     Impulse 2 
 

 
Fig. 18 
 
Description 
Apart from contracting triangles, a failure in a corrective pattern happens 
when the C wave is shorter than wave A and fails to go beyond the end of 
A. 
Happens in running flats or in zigzags. 
Indicated strength in the direction of the main trend. 

Rules and Guidelines 
The rules as mentioned with other corrective patterns apply. 
Wave C fails to go beyond the end of wave A. 
In Which Wave 
Failures can occur in a C wave 2, in a C or E wave of 4 in a C wave of B or 
X. 
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Corrections 
b. Failed Flat 

Pattern 

 

Fig. 19 
 
Description 
This pattern is exactly the same as a Flat, except for the fact the wave C 
does not reach the end of wave A and therefore is shorter than wave B. 
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Corrections 
c. Running Flat (modern) 

Pattern 
 

 
Fig. 20 

 
Description 
This pattern is exactly the same as a Running Flat, except for the fact that it 
must retrace more than 60%, of not ELWAVE considers it to be a normal 
Running Flat. This distinction is necessary, because normally a Running 
Flat is rare. But if it retraces more than 60% and still fails to race the end of 
wave A, it suddenly becomes a much more probable pattern to occur. In 
that case it will get a much higher score. 
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Channeling 
This is an important tool to determine which subwaves belong together and 
to project targets for the next wave up. 
Channels are parallel lines, which contain complete price moves. 
Trendlines of triangles are also considered a channel. 
The following is an example of a channel in impulse wave and a channel in 
corrective waves. 
 

 
 
Fig. 21 
 
Waves of the same degree can be recognized by drawing channels. 
Especially this is the case for Impulse (5) wave structures, Zigzags and 
Triangles. If these waves do not fit properly, you have a strong indication to 
search for an alternative count. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

26

Targets for Wave 3 or C 
To begin with you can draw a channel as soon as wave 1 and 2 are 
finished. Connect the origin of wave 1, which has been labeled as zero, 
and the end of wave 2. then draw a parallel line from the top of wave 1. 
Generally this channel is regarded as not being very useful, but it is, First of 
all the parallel line services as a absolute minimum target for the 3rd wave 
under development. If the 3rd wave can’t break through the upper line or 
fails to reach it, you are probably dealing with a C wave instead of wave 3. 
Furthermore the base line from 0 to wave 2 serves as a stop. When this 
base line gets broken, there is a strong probability that wave 2 (or B) gets 
more complex, thus wave 3 or C has not begun yet. 
Keep in mind that wave 3 is normally the strongest wave and often will go 
far beyond the upper trend line. 
 

 
 

Fig. 22 
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Targets for Wave 4 
As soon as wave 3 has finished you can draw a channel connecting the 
end of wave 1 and wave 3 with a trend line and drawing a parallel line from 
the end of wave 2. by Doing this you can project a target for wave 4. Keep 
in mind that normally the base line from wave 3 will be broken slightly by 
the price action of wave 4. If wave 4 doesn’t come near the base line at all 
this is a sign of a very strong trend. You are probably still in wave 3 or your 
should get ready to a blow off in wave 5. 
 

 

Fig. 23 
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Targets for Wave 5 

Method 1 
As soon as wave 4 has finished you can draw a channel connecting the 
end of wave 2 and wave 4 with a trend line and draw a parallel line from the 
end of wave 3 and project upward to wave 5. This is your target for wave 5. 
This would be for a normal wave 5. An extended wave 5 would push 
higher. It the price fails to hit the projected trend line to wave 5 then the 
market is weak and you should look for a sell off. 
 

 

Fig. 24 
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Targets for Wave 5 

Method 2 
Mostly wave 3 is the strongest wave showing a very fast acceleration 
relative to wave 1 and 5. If wave 3 indeed shows a nearly vertical rise or 
decline, then draw a trend line-connecting wave 2 and 4 and draw a 
parallel line from wave 1. This parallel line will cut through wave 3 and will 
target wave 5. Experience shows this is a very valuable channel. 
 

 

Fig. 25 
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Targets for Wave D and E 
As soon as wave B has finished you can draw a trend line connecting the 
origin of wave A and the end of wave B to get a target for wave D, provided 
a triangle indeed is developing, which is more certain after completion of 
wave C. 
As soon as wave C has finished you can craw a trend line connecting wave 
A and the end of wave C to get a target for wave E almost never stops at 
the trend line precisely, it either never reaches the trend line or it 
overshoots the trend line fast and temporarily. 
 

 

Fig. 26 
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Targets in a Double Zigzag 
Drawing a channel is very useful to separate Double Zigzags from 
impulsive waves, which is difficult since both have impulsive 
characteristics. 
Double Zigzags tend to fit a channel almost perfect, while in an impulsive 
wave the third wave clearly breaks out of the channel. 
 

 

Fig. 27 
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Fibonacci Ratios 
The Fibonacci series are a mathematical sequence in which any number is 
the sum of the two preceding numbers. 
The sequence goes as follows: 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 144 and so 
on. 
The properties of this sequence appear throughout nature and in the arts 
and science. Most notable is the ratio of 1.618  which is called the “Golden 
Mean”. It was discovered even in ancient times. The number can be 
approached by dividing a Fibonacci number by its preceding number as the 
sequence extends into infinity. The ratio of .618 is also very prominent 
when analyzing Fibonacci relationships.  
The wave counts of the impulse and corrective patterns 5 + 3 = 8 are 
Fibonacci numbers. 
Analyzing Fibonacci relationships between price movements is important 
for several reasons: 

1) You can control your wave analysis. 
2) The better the Fibonacci ratios of your wave count, the more 

accurate your count is, because in some way or the other all waves 
are related to each other. 

3) You can project realistic targets once you have distinguished 
different scenarios, which point in the same direction. 

4) Since Fibonacci manifests itself in the proportions of one wave to 
another, waves are often related to each other by the ratios of 2.618, 
1.618, 1, 0.618, 0.382 and 0.236. This fact can help you in 
estimating price targets for expected waves. If , for example a wave 
1 or A of any degree has been completed, you can project 
retracements of 0.382, 0.50 and .618 for wave 2 or B, which will give 
you your targets.  

5) Most of the time the third wave is the strongest, so often you will find 
that wave 3 is approximately 1.618 times wave 1.  

6) Wave 4 normally shows a retracement, which is less than wave 2, 
like 0.236 or 0.382. If wave three is the longest wave, the 
relationship between wave 5 and three often is 0.618. 

7) Also wave 5 equals wave 1 most of the time. 
8) The same relationship can be found between A and C waves. 

Normally C equals A or is 1.618 times the length of A. 
9) You can even combine waves to find support and resistance zones. 

For example the next price movement of wave 1 and 3 times 0.618 
creates another interesting target for wave 5.  

10) It is worthwhile to experiment a lot with your wave count, Fibonacci 
will help you to solve the rhythm of the markets. 
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Targets 

Wave 1 
The first wave of a new impulsive price movement tends to stop at the base 
of the previous correction, which is the B wave. The often coincides with a 
38.2% or a 61.8% retracement of the previous correction. 

Wave 2 
Wave 2 minimally retraces 38.2% and mostly 61.8% or more of wave 1. It 
often stops at subwave 4 and more often at subwave 2 of previous wave 1. 
A retrace of more than 76% is highly suspicious, although it doesn’t break 
any rules yet. 
 
Wave 3 
Wave 3 minimally is equal to wave 1, except for a 
Triangle. If wave 3 is the longest wave it will tend to be 
161% of wave 1 or even 26l%. 
 
Wave 4 
Wave 4 minimally retraces 23% of wave 3 and more often reaches a 38.2% 
retracement. It normally reaches the territory of subwave 4 of the previous 
3rd wave. In very strong markets wave 4 could only retrace 14% of wave 3. 
 
Wave 5 
Wave 5 normally is equal to wave 1 or travels a distance of 61.8% of the 
length of wave 1. It could also have the same relationships to wave 3 or it 
could travel 61.8% of the net length of wave 1 and 3 together. If wave 5 is 
the extended wave it mostly will be 161.8% of wave 3 or 161.8% of the net 
length of wave 1 and 3 together. 
 
Wave A 
After a Triangle in a fifth wave, wave A retraces to wave 2 of the Triangle of 
previous wave 5. When wave A is part of a Triangle, B or 4 it often retraces 
38.2% of the complete previous 5 wave (so not only the fifth of the fifth) into 
the territory of the previous 4th wave. In a Zigzag it often retraces 61.8% of 
the fifth wave. 
 
Wave B 
In a Zigzag wave B mostly retraces 38.2% or 61.8% of wave A. In a Flat, it 
is approximately equal to wave A. In an Expanded Flat, it usually will travel 
a distance of 138.2% of wave A. 
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Wave C 
Wave C minimally has a length of 61.8% of wave A. It could be shorter in 
which case it normally is a failure, which foretells an acceleration in the 
opposite direction. Generally wave C is equal to wave A or travels a 
distance of 161.8% of wave A. 
Wave C often reaches 161.8% of the length of wave A in an Expanded 
Flat. In a contracting Triangle wave C often is 61.8% of wave 
A. 
 
Wave D 
In a contracting Triangle wave D often travels 61.8% of wave B. 
 
Wave E 
In a contracting Triangle wave E often travels 61.8% of wave C. It cannot 
be longer than wave C! 
 
Wave X 
Wave X minimally retraces 38.2% of the previous A-B-C correction; a 
retracement of 61.8% is also common. 
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Trading the Elliott Wave 
The Elliott Wave provides you with the most objective and disciplined 
method available for trading. Only a handful of patterns exist, sometimes 
easy to recognize especially in strong impulsive waves. The available 
patterns tell you where the market is heading; in what way (or structure) 
this will happen and under what circumstances the pattern gets a stronger 
probability. Also the pattern will tell you when it is no longer valid because 
of the occurrence of an intolerable price action. This makes it possible to 
exactly determine your entry and exit points, which is an outstanding 
characteristic of the Elliott Wave. 
 
The key to forecasting markets with the Elliott Wave lies in determining the 
probabilities of alternative scenarios. If you find several alternative counts 
pointing in the same direction, you have found an excellent trading 
opportunity. 
 
Some people, mainly those who could not successfully apply the Elliott 
Wave themselves, will tell you either it is too complex and subjective or that 
the waves don’t exists at all, suggesting the market follows a random 
pattern. 
 
Obviously the Elliott Wave can get very complex-especially in corrective 
waves- since you will have to look for patterns, which contain patterns, 
which contain patterns etc. etc. But it never loses its objectivity if you apply 
the rules and guidelines. The only problem is that sometimes it is not totally 
clear if the internal structure of a wave is a 3 wave or a 5 wave. In that case 
you will have to determine alternatives for both internal wave structures and 
look for other confirmations, such as channels, indicators and Fibonacci 
ratios. Below we will mention the key steps for Elliott Wave analysis and 
supply basic trading patterns to search for. 
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General Directives for Trading 
Now you can use the Automatic Analysis to trade profitably, the more 
probable an outcome the better opportunities. The more alternatives point 
in the same direction the more certain the market will move accordingly. 
The Automatic analysis will generate an ever objective and consistent wave 
count and will always present the most probable outcome first, set by 
objective rules and guidelines implementing a true Elliott Wave model. 
Those who really would like to learn the Elliott Wave have to really study 
the ins and outs. In the following we offer some directives. These directives 
come from our own experience as well as many publications on this 
subject. Of course every trader or analyst should find his own path to 
success. 
 
Study the Patterns  

• know the rules and guidelines 
 

• learn the internal structure of patterns, which enables you to 
recognize a pattern within a pattern 

• remember that only waves 1,3,5, A and C can be impulsive waves 
 

• all other waves are corrective, against the trend, and show overlap 
in their internal structure 

 

Design Alternative Scenarios by Labeling the Chart. 
• Start labeling the chart by taking into account the following rules and 

guidelines: 
 

• Separate impulses from corrections, an impulse normally shows 
acceleration and no overlap, a correction a sideways pattern 
 

• Waves of the same degree should have the same proportions, 
which is especially important for wave 2 and 4. A minuscule 4th 
wave cannot belong to a big wave 2 and so on. 
 

• Wave 2 can never retrace more than 100% and go beyond the 
origin of wave 1. 
 

• Wave 3 normally is the longest wave and shows the most powerful 
acceleration 
 

• In wave 3 there is never an overlap between wave 4 and 1, as it 
occurs in fifth waves (and first or A waves 
 

• Label the big picture, is it a three or a five? 
 

• Label more in detail, by labeling the smaller wave degrees, then go 
back to the large wave degrees, changing your labels if necessary 
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• Check if the required internal structure of your waves comply with 
the rules and guidelines. For example a B wave never can consist of 
five waves and so on 
 

• Check if the internal structure of the internal structure is correct. For 
example an (expanded) Flat consists of a 3 wave, again a 3 wave 
and a 5 wave structure. If this is not true, change your labeling 
 

• Check your wave count for alternation, especially with wave 2 and 4. 
If wave 2 showed a simple Zigzag, wave 4 should show a complex 
pattern 
 

• A corrective pattern mostly minimally carries into the territory of the 
4th wave of the previous impulse wave 
 

• Use momentum indicators and volume to support your wave 
labeling. Wave 3 should have the highest momentum and volume (if 
it is the longest wave).  

• Calculate Fibonacci relationships. If your wave count reveals a lot of 
reasonable Fibonacci ratios, you have found an interesting count. 
 

• Throw in channels and determine if your wave count more or less 
fits these channels  
 

• Design as many scenarios as the Wave Principle allows for, with 
regard to the wave degree or time frame you are analyzing 
 

• Do the same for shorter and longer time frames (or lower and higher 
wave degrees) and try to narrow down alternatives by fitting them to 
a multiple of wave degrees 
 

• Assess the probabilities of these scenarios by studying their 
compliance with the permitted internal wave structure, the outcome 
of Fibonacci ratios and the fit of channels 
 

• Draw the expected price action/pattern of each scenario you have 
designed, mark price levels where you get signals to enter/exit 
market. 

 
Design a Trading System 

• Determine what time frame (or wave degree) you would like to trade 
 

• Determine which patterns and alternative wave counts give the best 
trading opportunities, such as when several alternatives all produce 
a price movement in the same direction 
 

• Determine objective entry points based on patterns 
 

• Determine objective exit points, also based on patterns. You should 
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for example exit a trade when a price movement makes your 
preferred wave count invalid. 

 
Control Your Emotions 

• Don’t be afraid to take a loss if your stop gets hit. This means you 
will have to admit you were wrong on this trade. Don’t be afraid of 
loosing the (little) profit you have made, only exit if your system or 
wave analysis tells you to 

• Follow the rules of the Elliott Wave and don’t second-guess the 
market. Believe what the Elliott Wave tells you, your stop will protect 
you 

• Of course there will be loosing trades; a 100% score is impossible. 
But if you limit your losses (by executing your stop) and let your 
profits run, you could be very successful. So maintain your discipline 
and learn from all trades 
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Trading Example 
In this section you will be shown how to recognize an impulsive wave from 
a corrective wave. In the same way as these basic patterns are compared 
and analyzed here, you can do it yourself with all other patterns. Suppose 
the market has experienced a big sell off. From the bottom it starts to rise. 
Wave 1 (or A) and wave 2 (or B) have been completed and the market 
starts to rise again. The first picture shows two scenarios possible, either 
an impulse (1,2,3) or an A,B,C correction. The pictures there under 
demonstrate which price action to expect in an impulse or in a correction: 
The pattern can be an impulse only if the 4th wave does not overlap the 
first, a level indicated by the horizontal “stop” line. As soon as the price 
drops under this line-before wave 5 has been completed- you have your 
first signal of a pending correction (picture above at the right). This 
correction will be confirmed when the price drops under the origin of wave 
C, which is the end of wave B. As long as it doesn’t drop under the 
“confirmation” line, it could still be an extended 3rd wave that subdivides. In 
that case the C or 3 wave is only wave 1 of the third wave! You will find the 
pattern called extension under the chapter “Patterns”. 

 

Fig. 28 
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See the successful impulse wave 1 on the AOL chart. 

 
 
See the failure of a wave to go up and the result of and an A B C correction 
wave in the gold chart. 
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Indicators 
A selective set of indicators can help you determine the wave structure. 
Remember that an Elliott Wave trader makes his trading decision mostly on 
the wave count and not solely on indicator values, On the other hand some 
indicators can be very helpful, because they show specific characteristics in 
different waves. 
 
Indicators can be added to the price chart or in a separate window. 
Normally, indicators like moving averages and others, which have the same 
scaling as a price chart, are added to the price chart itself. Other indicators, 
like RSI for example, are clearer if displayed in a separate window. 
 
The most useful indicators are the following, not all of them have been 
explained, since all books on technical analysis already clarify their use: 
 

• RSI 
• MACD 
• DM1 
• Momentum 
• Exponential Moving Average 
• Simple Moving Average 
• Displaced Moving average 
• Rate of Change 
• Elliott Oscillator 
• Stochastic 
• Volume 
• Bollinger Bands 

 
Indicators always have the same compression as the price chart. For 
example if the RSI has been set to a time period of 14 and a daily bar is 
displayed in the price chart, then the RSI will calculate a 14-day RSI. If you 
change the price chart to weekly, the RSI will calculate a 14-week RSI. The 
same accounts for intra day (intra day version only), for example an hourly 
chart creates an 14-hourly RSI and so on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

42

Relative Strength Index 
Relative Strength Index (RSI) is an oscillator developed by J. Welles 
Wilder, JR. It is a very popular indicator and useful when applying the Elliott 
Wave. 
 
RSI measures the strength of any price action by monitoring changes in its 
closing prices. It is a leading or a coincident indicator, it never lags the price 
action. The RSI indicator fluctuates between 0 and 100. Horizontal 
reference lines in the RSI are often drawn at 30 and 70. 
RSI gives several buy or sell signals, which are divergences, patterns, 
trend lines and the absolute level of RSI, the RSI levels as already 
mentioned. Divergences are the most important signals. Divergences 
between RSI and prices give the strongest buy and sell signals. Normally 
this happens at tops and bottoms in an impulsive wave, which consists of 
five waves. If the C wave is equal in length to wave A, the RSI should also 
show a divergence. Generally a divergence indicates that the trend is weak 
and ready to reverse. 
 
A bullish divergence gives a buy signal, when prices fall to a new low but 
RSI fails to make a new low. You can buy as soon as the first RSI bottom 
has been below its lower reference line (for example at 30) and the second 
bottom of the RSI happens above the reference line. See chart below. 
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A bearish divergence works exactly the same, but the other way round. It 
gives sell signals. You can sell as soon as the first RSI high has been 
above its higher reference line (for example at 70) and the second top of 
the RSI happens underneath the reference line. See Chart below. 
 
Trend lines, support and resistance lines, and patterns, like “head and 
shoulders”, work fine with RSI. Because RSl leads the price chart, it often 
gives early warnings of likely trend changes. RSI trend lines are penetrated 
before it happens in the price chart and patterns can be completed a few 
days before completion in the price chart. Of course the fifth wave of a RSI 
mostly is a failure, except when the fifth wave is an extension. 
 
RSI levels indicate that above 70 the market is overbought, which calls for 
a correction, although the RSI can reach 80 and more in a bull market. 
Under 30 the market is oversold, so a rise can be expected, but be careful 
because in a bear market a RSI beneath 20 is quite common. So when the 
RSI goes above 70 and certainly above 80, look for a selling opportunity. 
Beneath 30 and certainly 20 you should look to buy. 
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Moving Averages (MA) 
A 10 day MA shows the average price for the past 10 days, a 30-day MA 
shows the average price for the past 30 days. A moving average normally 
will be displayed in the price chart as a line, by connecting each day’s MA 
values. 
 
Moving averages can be calculated as a simple moving average, which 
gives each day an equal weight. 
 
Also, an exponential moving average can be calculated, where the latter 
days are heavier weighted. With a moving average you can see the main 
trend more easily, because it filters out the small price movements. When it 
rises, the moving average shows that investors become more optimistic. 
When it falls, investors become more pessimistic. 
 
An exponential moving average (EMA) is a better trend-following indicator 
than a simple MA, because it responds faster to the latest price changes 
than a simple MA and skips older data which are less relevant. 
For the investor moving averages are most helpful in following the trend. 
The direction of its slope in each time frame tells you what the trend of this 
specific time frame is. Be sure to trade in the direction of the trend of the 
time frame you use. When you are trading a trend, you can use a short 
term MA as a stop. See 30 EMA below. 
 
In the price chart you could also display a short term MA and a longer term 
MA. When the shorter term MA crosses the longer MA in upward direction 
this is a buy signal, which confirms the up trend. When it dips under the 
longer term MA this is regarded as a sell signal. Be careful with this signal, 
because a sideways market shows a lot of crossovers and thus a lot of 
false signals. You can also use a moving average as a stop. The shorter 
your investment horizon the shorter your moving average should be. As 
soon as prices break the moving average line you can close your position. 
This can be very useful if you want to invest in a third wave only. 
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Moving Average Convergence Divergence (MACD) 
Gerard Appel has constructed a more advanced indicator, called the 
Moving Average Convergence-Divergence, or MACD, which is built of three 
exponential moving averages. It is displayed as two lines, the MACD line 
and a the Signal line. The MACD line is built out of two exponential moving 
averages (EMAs). The signal line is built from the MACD line smoothed 
with another EMA. The MACD line responds more quickly to changes in 
prices. 
 
Buy and sell signals occur when the fast MACD line crosses above or 
below the slow Signal line. 
 
You can use the crossovers of the MACD and signal lines to trade with the 
trend of the market. The fast MACD line crossing above the slow Signal 
line gives a buy signal. The fast MACD line crossing below the slow Signal 
line gives a sell signal 
 
Also you can look for divergences as explained with the RSI to determine 
the momentum of the market. Again a wave 3 should have the lowest (bear 
market) or highest (bull market) MACD. Divergences in the MACD don’t 
work on longer term. 
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Momentum 
The Momentum indicator shows how strong the trend is by measuring its 
acceleration. The faster Momentum gains or loses speed the more the 
trend accelerates. This is a leading indicator, which usually reaches a peak 
before prices reach their highs and reaches a bottom before prices reach 
their lows. 
 
The trend is up as long as Momentum gets higher and higher, you can 
normally hold on to your bullish positions. As long as it keeps reaching new 
lows, you can hold on to your short trades. Every time Momentum reaches 
a new high, the up trend is still accelerating. Every time Momentum 
reaches a new low, the downtrend is still accelerating. 
When the direction of Momentum changes, without having set a divergence 
already, be prepared for a reversal. 
 
You can use Momentum to catch large trends, for this purpose use a longer 
time frame. If you want to spot changes in the trend quickly, then use a 
shorter period Momentum. 
 
When the direction of Momentum changes, the pattern could be the third of 
a C wave or the third of a five wave. A small correction will take place to 
form the 4th wave. The fifth wave still has to develop in the same direction 
of the trend. When this fifth wave is underway, you can cover your shorts or 
sell your longs. 
 
Again a divergence is one of the most powerful signals, which normally 
occurs in every five wave structure. The bigger the divergence the sharper 
the reversal can be. If Momentum fails to make a new high or low, this 
could be a C wave or a five-wave structure, which depends on the wave 
structure of larger degree. 
 
If you can recognize five waves in a C wave in a larger trend, which points 
to the opposite direction, and at the same time Momentum makes a lower 
top or a higher low, it is better to close your (trend following) positions at 
once. After a C wave the reversal could be quite sharp. On the other hand, 
if the larger trend is still up, this only could be wave 3 with wave 4 and 5 to 
follow. Here you could hold on to your positions depending on the wave 
degree you have determined. In a larger degree a bigger reversal can be 
expected, making it worthwhile to exit. Later on you could possibly reenter 
at a better price. 
 
You can also draw trend lines or channels to identify support and 
resistance in indicators. Usually Momentum breaks through its resistance a 
long time (relatively speaking) before prices do. 
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Rate of Change 
Rate of Change is quite similar to Momentum, since it also measures the 
strength of a trend. The only difference is that Rate of Change is calculated 
differently. It divides today’s price by a past price. The faster Rate of 
Change gains or loses speed the more the trend accelerates. This is a 
leading indicator, which usually reaches a peak before prices reach their 
highs and reaches a bottom before prices reach their lows. 
 
The trend is up as long as Rate of Change gets higher and higher, you can 
normally hold on to your bullish positions. As long as it keeps reaching new 
lows, you can hold on to your short trades positions. Every time Rate of 
Change reaches a new high, the up trend is still accelerating. Every time 
Rate of Change reaches a new low, the downtrend is still accelerating. 
 
When the direction of Rate of Change changes, without having set a 
divergence already, then be prepared for a reversal. 
You can use Rate of Change to catch large trends, for this purpose use a 
longer time frame. If you want to spot changes in the trend quickly, then 
use a shorter period for Rate of Change. 
 
When the direction of Rate of Change changes, the pattern could be the 
third of a C wave or the third of a five wave. A small correction will take 
place to form the 4th wave. The fifth wave still has to develop in the same 
direction of the trend. When this fifth wave is underway, you can cover your 
shorts or sell your longs. Again a divergence is one of the most powerful 
signals, which normally occurs in every five-wave structure. The bigger the 
divergence the sharper the reversal can be. If Rate of Change fails to make 
a new high or low, this could be a C wave or a five-wave structure, which 
depends on the wave structure of larger degree. If you can recognize five 
waves in a C wave in a larger trend, which points to the opposite direction, 
and at the same time Rate of Change makes a lower top or a higher low, it 
is better to close your (trend following) positions at once. After a C wave 
the reversal could be quite sharp. On the other hand, if the larger trend is 
still up, this only could be wave 3 with wave 4 and 5 to follow. Here you 
could hold on to your positions depending on the wave degree you have 
determined. In a larger degree a bigger reversal can be expected, making it 
worthwhile to exit. Later on you could possibly reenter at a better price. 
 
You can also draw trend lines or channels to identify support and 
resistance in indicators. Usually Rate of Change breaks through its 
resistance a long time (relatively speaking) before prices do. 
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Elliott Oscillator 
This indicator is very useful in counting waves. It was discovered by Tom 
Joseph in 1987 and named the Elliott Wave Oscillator. 
 
The pattern this oscillator produces has a strong correlation with the pattern 
of the Elliott Wave. For example the 3rd wave mostly is the strongest wave. 
At this point generally the Elliott Oscillator shows the highest value, thus 
confirming a 3rd wave. The Elliott oscillator works in all time frames, 
provided you have enough periods or bars available in your price chart. In 
order for the Elliott Oscillator to produce reliable values your price chart 
should contain 100 bars minimally. 
 
If you work with intra day data, you can zoom in on each wave to check the 
pattern of the Elliott Oscillator, as long as enough detail is available. 
 
Formula: 5-period MA - 35 period MA of the (High + Low) /2 
A divergence between the Oscillator and prices indicates a trend reversal. 
When the market has set new lows but the Oscillator does not, you have 
probably found wave 1 in Elliott terminology. 
When you spot this divergence you could do your first trade and buy the 
market. At this juncture risk is high, so watch the market closely. Always 
sell when the market reaches a new low, since this could be the beginning 
of a renewed sell off. 
 
Next a correction will take place, which is wave 2. Neither the market will 
reach new lows in wave 2, nor will the Elliott Oscillator. If wave 2 is 
complex, the oscillator will pull back to zero. A simple wave 2 on the 
contrary will hardly affect the oscillator. When the oscillator reaches zero 
you could buy again to profit from the coming 3rd wave, on the condition 
that the pattern of supposedly wave 2 is corrective (when it shows a lot of 
overlap and not a 5 wave) 
 
Then the market will build wave 3, normally the strongest price movement. 
Both the indicator and the market will reach new extremes. As soon as 
wave 3 has gone beyond wave 1, the market will accelerate sharply. The 
oscillator does not provide for an exit point in this time frame or wave 
degree, so you have to look at the subwave of this wave degree. If you 
detect a divergence between subwave 3 and wave 5 of the main 3rd wave, 
you have found your exit. 
 
After wave 3 again a correction will take place in wave 4. Notice that wave 
4 will be complex if wave 2 was simple and vice versa. Normally (90% of all 
4th waves) the oscillator will at least retrace to zero in wave 4. 
As long as the oscillator does not retrace more than 138.2% of the wave 
three peak, the correction is considered to be wave 4. If it retraces more 
prepare yourself for a decline, since there is a strong probability that the 
price rise was a corrective three wave in a contra trend price movement. 
When the Oscillator reaches zero you could enter the market again to profit 
from wave 5, on the condition that the pattern of wave 4 was corrective. 
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Most of the time the market will make new highs in the 5th wave, but the 
oscillator won’t come near its top in wave 3. This divergence is a strong sell 
signal, on the condition that the pattern of the 5th wave is complete. If both 
the oscillator and the market make new highs, you will have to relabel the 
5th wave to wave 3!  
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The ELWAVE Program - Introduction 
Attention: 
You will need the special “Automatic analysis” module to automatically 
analyze price data according to the Elliott Wave Principle. In addition, you 
will need the “Trading signals” module to generate trading indications 
automatically. 
In this chapter we will introduce you to our Elliott Wave software. We will 
show you how to use ELWAVE without the requirement of being an Elliott 
Wave expert. 
Now Elliott Wave analysis and trading is just a few mouse clicks away. 
For experts we explain the possibilities and advanced features in the 
Chapters “AUTOMATIC ANALYSIS”, “TRADING SIGNALS” and “MANUAL 
WAVE COUNT”. 
The Automatic analysis chapter will briefly describe how our Elliott Wave 
model works, a short description of analysis options, the difference 
between the CLASSIC and MODERN rules and how to inspect the 
alternatives ELWAVE has found. 
The Trading signals chapter explains the outcome and interpretation of the 
signal indications as well as further explanation of the SUMMARY 
INSPECTOR, the ALERTS INSPECTOR and the SIGNALS INSPECTOR. 
The Target clusters chapter explains how to interpret time projections using 
the TIME CLUSTERS indicator or the Target zone, which can be shown in 
the chart. 
The chapter Manual Wave count explains how to make an Elliott Wave 
count yourself instead of have ELWAVE do it for you. Of course you have 
to be an expert to make a high quality count, but fortunately ELWAVE is 
able to check the count, even if you have the Basic module only. In addition 
you will find more information about the WAVE INSPECTOR and the 
WAVE TREE. 
If you are looking for explanation on specific topics, check out the chapter 
“Technical Tools-Extra information”. Here you will find more information on 
for example loading and saving data and scenario files, the price chart 
window, trend lines, channels, time ratio ruler and real-time data feed. For 
your convenience we have also added a chapter that describes the menu 
options one by one, called “Using the menu”. 
Naturally we have included an extended chapter on the basics of the Elliott 
Wave Principle and a detailed description of the Elliott Wave patterns. 
Reading is not required to use the software, but still highly recommended. 
Our manual concludes with a short chapter on Indicators. Not all indicators 
have been explained, because many books on interpretation and use of 
these indicators are available. We recommend getting more information on 
indicators from other sources as well. 
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Our Automatic analysis uses a true Elliott Wave model to detect validated 
patterns and to determine the direction of prices, thus enabling you to 
forecast markets more accurately. In this section you will learn the 
essentials in order to start using the program right away, assuming you 
have purchased the full End of Day or Intra day version. If you have the 
Basic version only, please go to chapter “Manual Wave count”.  
After you have followed the steps listed below you will be able to use 
ELWAVE. We have assumed that you are familiar with the Windows 
environment, the way the menu works and so on. If not, you will have to 
study your Windows manuals. 
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Quick Start 
1. On top of the screen the main menu is listed, click on the menu item to 
access its options. 
 

 
 
2. Load an existing scenario file by choosing Open from the Scenario menu 
or choose New and From price data to import data. Select the directory that 
contains your data and choose the correct FILE TYPE. 
 

 
 
3. After the chart has been loaded, choose Analyze entire chart from the 
Analyze menu. 
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4. Press the TARGET ZONE button in the right lower corner of the chart 
window. 
 

  
 
5. This will then draw the TARGET ZONE and expected market PATH. 
 

 
 
5. ELWAVE will present all information you need after completion of the 
analysis, such as 
• Preferred alternative  
• Targets 
• Trading signals  
• Entries, exits, risk / rewards etc. 
 

 
 
Now take a look at the SUMMARY INSPECTOR to spot opportunities 
easily in the EASI indicator column. The more positive indications shown, 
the stronger the uptrend and vice versa. It’s that simple. 
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Analysis Results 
We will now discuss how  ELWAVE presents analysis results when you 
have taken the steps as mentioned before. After completion of an 
automatic Elliott Wave analysis, ELWAVE will come up with more or less 
the following screen. 
 

 
 
As you see, a lot of information is available, which we will explain step by 
step in the following sections. 
In all predefined layouts (see Analysis menu) ELWAVE will show the 
SUMMARY INSPECTOR, which probably gives the most important and 
concise information as depicted in the picture below. 
Additionally the expected market PATH as well as the more specific 
TARGET ZONES are pictured below. 
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Price Chart window 
In the default layout this window is presented at the left. of the screen. It 
contains for example the price data, the wave labels that have been 
inserted by ELWAVE and the automatic channels. 
In this example an analysis of 100 years of Dow Jones data, 3 wave 
degrees or time frames are displayed. 
Every wave degree has a different color, all connected objects, such as 
channels, target bars, have the same color. TARGET BARS are displayed 
as vertical lines, representing the minimum and maximum expected target 
of the selected pattern. The small diamonds represent the average targets, 
which correspond with the information in the SUMMARY INSPECTOR (see 
below). For easy recognition, these diamonds inherit the color of the wave 
degree or time frame to which they belong. The same goes for the triangles 
that represent the exits. 
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Toolbars 
On top of the screen, just underneath the main menu, two toolbars are 
displayed (See the pictures on the previous pages). The OBJECT toolbar 
or Chart objects contain buttons  

 
 
for inserting channels, trend lines, time rulers, spirals and trigger lines. 
Grab the button and drag it into the chart and release it at the required 
spot. 

 
 
The WAVE LABEL toolbar,  
The wave label toolbar, which by default lists the “Supercycle” wave labels, 
can only be used when determining your manual wave count. The setting 
of this toolbar to a specific wave degree has nothing to do with the 
automatic Elliott Wave analysis. 
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Wave Tree 
The WAVE TREE is a tree-structured representation of the first Elliott Wave 
analysis that is displayed in the chart. It is displayed at the left of the 
screen. On top of THE WAVE TREE, two buttons “PREVIOUS” and 
“NEXT” can be found. Clicking these buttons will only affect the highest 
wave degree and scroll to the next or previous Elliott Wave alternative. To 
take a look at alternatives from lower degrees, click that particular WAVE 
BUTTON and click the right mouse button and scroll the alternatives. 
The WAVE TREE itself is composed of WAVE BUTTONS, each of them 
represent a wave in the chart, which in fact is a small or large trend or 
correction. Together, a group of WAVE BUTTONS build a higher wave 
degree of a larger time frame. 
Clicking a WAVE BUTTON, that displays a wave label, will show that 
particular wave with the required wave detail, all of its channels and other 
connected objects. 
The small + or - buttons make the WAVE TREE expand or collapse. If you 
press the + button, the underlying patterns that consist of several waves, 
each represented by a separate WAVE BUTTON, will be displayed. By 
expanding the WAVE TREE and selecting lower level waves, you can 
navigate as deep down into the wave structure as you like. This will show 
which patterns ELWAVE has found. The patterns found are listed at the 
right of the WAVE BUTTON. 
The most interesting Waves are the unfinished waves, which can be 
recognized by the gray cross in THE WAVE BUTTON. Obviously a correct 
forecast of the pattern in an unfinished wave is the key to forecasting 
markets. 
In case a red cross appears in the WAVE BUTTON, the patterns in this 
wave or in the underlying waves are either not found or are not allowed. 
If the Trading signals module is included, double clicking a WAVE BUTTON 
will show the trading signals for the pattern under inspection. 
At the left in the SIGNAL INSPECTOR the trading indications are listed 
together with the critical price level. At the right the patterns that share this 
signal, are listed. At the bottom the description of the rule, on which the 
trading indication is based, is displayed.  
Trading signals in ALL CAPS already have been triggered, while Trading 
signals in lower case have not yet been activated, because their critical 
price level is not reached. There are four signals: 
Entry, to enter a position, which is a buy or sell indication depending on the 
trend 
Exit, to exit a position, which is a buy or sell indication depending on the 
trend 
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Confirm, this is an alert that the trend has been confirmed, depending on 
your strategy this can either be used as an entry or an exit 
Recalc, if this price level gets penetrated, ELWAVE will update the analysis 
because a critical price level has been broken, its price level will coincide 
with some other signals 
Use the scroll bars at the right side of the WAVE TREE window or at the 
bottom to scroll the tree. 
As shown in the picture below, clicking on the WAVE BUTTON (or pattern) 
in the WAVE TREE displays this wave in the price chart, the SWING 
FILTER (light blue line), a text book example of an impulse pattern and 
connected TARGET BARS. 
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Wave Inspector 
The WAVE INSPECTOR gives a lot of additional information on the pattern 
under inspection. It is not necessary to inspect this information; 
nevertheless it could be a valuable tool in your trading. Certainly it will 
teach you which rules and guidelines determine the patterns. 
The WAVE INSPECTOR will always display information on the pattern that 
has been selected as in this case, where the pattern Impulse has been 
highlighted in the left list box on top of the WAVE INSPECTOR. 
At the left the still validated patterns are listed, at the right dismissed 
patterns are listed. If you choose one of the dismissed patterns, you will 
notice that at least one of the rules of the pattern has been violated and 
checked by a red cross. 
Use the scroll bar at the right side of the WAVE INSPECTOR window to 
see more. In the following pictures we have shown the available 
information. 
 
The score on top in bold in the WAVE INSPECTOR is the total score, 
which is used to rank the alternatives. 
The better the Fibonacci ratios, the better the Elliott Wave analysis. 
Clicking on the rules and guidelines in the WAVE INSPECTOR will display 
the critical price levels, where the rules or guidelines get violated, in the 
chart. 
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Summary Inspector 
Probably the SUMMARY INSPECTOR gives the most important and 
concise information, eliminating the need of being an expert Elliott analyst. 
Using this information will give clear indications on how to trade and when 
to enter or exit positions. 

 
Apart from the SUMMARY INSPECTOR it is recommended to take into 
account other information and use other tools as well, in order to make the 
best trading decision possible.  
By default, the SUMMARY INSPECTOR is displayed at the bottom of the 
screen. The column called EASI is the main thing to watch in combination 
with the R/R (risk-reward) parameter. As long as the AVG R/R is above 
zero the EASI column will give a positive or negative indication, depending 
on the trend. If the AVG R/R turns negative, the EASI will become a 
“neutral”. 
If all time frames display the same signal, either a “Positive” or “Negative” 
and the AVG R/R is above 1, then expect an acceleration in the direction of 
the trend, provided a large price movement has not yet taken place. A risk-
reward of 2 or more is very favorable as long as this is not caused by an 
extremely small risk in the RISK column. 
After ELWAVE for example shows a “Positive” on every time frame, at 
some point the EASI column of time frames (the smallest time frame first) 
will turn into a “Neutral” as soon as the TARGET has been reached. As 
said before TARGETS are displayed in the chart by a diamond, while 
EXITS are displayed as little triangles. Both TARGET and RISK are 
presented in points. 
Normally a “Neutral” means you can still hold on to your positions. If he 
smallest time frame turns to a “Negative” or the EXIT, as listed in the 
SUMMARY INSPECTOR, is penetrated, you have a signal to exit your 
positions, depending on your trading strategy.  
If the EXIT level gets hit this does not automatically mean that the position 
should be abandoned, especially if the EASI is still a positive (Negative in 
down market) or a hold. Consider the EXIT to be the first warning signal of 
a reversal, which has yet to be confirmed. In Elliott terminology the stop of 
at least one alternative has been hit, invalidating this scenario, but other 
alternatives could still be possible. 
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In case all alternatives have been dismissed, because all their exits have 
been triggered, the SUMMARY INSPECTOR will show a change in the 
TREND column and /or the EASI column. 
These time frames, as highlighted in the above picture, show the relative 
order of the trends within trends or pattern within patterns that ELWAVE 
has found automatically. Time frames of the same degree normally do not 
exactly have the same duration; they are dynamic in nature. 
The lower listed TIME FRAMES (or wave degrees) in the SUMMARY 
INSPECTOR are smaller trends in a larger trend (or the higher listed TIME 
FRAME).  
Therefore an Intermediate time frame is a smaller trend in the Primary and 
so on. 
Please note that a wave degree as listed in the SUMMARY INSPECTOR is 
not related to the duration of the wave degrees as normally defined by the 
Elliott Wave Principle, which definitions are only tendencies, not fixed and 
exact.  
RISK shows the number of points you risk if you adhere to the exit in the 
EXIT column. 
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ELWAVE in a Nutshell 
1. Only the very first time you have to import an existing (intra day) data file 
for each security or market provided you save it as a scenario file, which 
you load the next time. With respect to intra day files, you should use an 
already existing intra day file and have this updated by the real-time feed 
(make sure the date and other formats are the same). Alternatively you can 
start a file from scratch using a real-time data feed! 

 
 
2. Select New from Scenario menu and next From Price data to import 
data: Import existing data files, choose the type of data to import by 
selecting FILES OF TYPE in the dialog box as displayed above. Next 
cruise to the directory where your data files are located. The formats 
supported are Metastock3.1-6.5, ASCII, TC2000 3.0-4.0, FutureSource, 
CSI, Keyword and Techtools. From real-time feed, to start collecting tick by 
tick, building your own intra day files from scratch 
3. Files of the type you have specified will be listed in the right pane. Click 
on the file in the right pane once and click on OPEN 
4. Once you have imported the data, immediately save the chart as a 
scenario file for later use, giving it the name of the security or market. This 
makes it easier to load the data file and will save real-time feed settings as 
well. In addition, a print out of the chart will have included the scenario file. 
In order to do so, choose Scenario and select Save .  
 
5. The next time you would like to analyze this market, just load the 
scenario file you have just saved, choose from the main menu Scenario 
and select Open, the scenario file will remember where to find the data file 
automatically. 
6. ELWAVE will use a default analysis layout to present results, taking into 
account your screen resolution. If you like, you can readjust all the windows 
to make a tailor made layout. Save it by selecting Analyze from the main 
menu and by choosing the option Save Custom layout. 
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7. Start Automatic Analysis by choosing Analyze from the main menu and 
select the option Analyze entire chart to generate an analysis from scratch. 
Of course you must have loaded data first. You may analyze a market from 
scratch or analyze an existing wave count in more detail (see examples in 
the next chapter). ELWAVE will present still remaining alternatives together 
with their targets and channels automatically. 
8. The SUMMARY INSPECTOR will show concise information about 
several time frames. The most important information to watch is the Trend 
and EASI (Elliott Advanced Signals Indicator). For each time frame EASI 
will show Positive, Negative or Neutral, if 2 or 3 consecutive time frames 
show positive or negative, an interesting trading opportunity is emerging in 
the direction of the trend.  
9. Press the TARGET ZONE button, which is located in the lower right 
corner of the chart window, to show the expected path of prices as well as 
the target zones in the chart. 
10. Save your analysis by choosing Save from the Scenario menu 
11. More detailed analysis using results of Automatic analysis, the WAVE 
TREE has appeared at the left after you have analyzed the entire chart as 
described under point 7, click with your left mouse button on the wave 
(button) in the WAVE TREE you want to analyze select Analyze from the 
main menu choose the Analyze selected wave option. 
12. Using a wave count defined by the user: 

• first load your scenario file containing your own wave count 

• select Analyze from main menu 

• choose option Check wave count 

• if this is your first time, accept the settings of the dialog box by 
clicking OK 

• The WAVE TREE appears at the left, click with your left mouse 
button on the wave (button) to be analyzed 
select Analyze from the main menu  

• choose Analyze selected wave option 
13. ELWAVE will present the preferred wave count in the WAVE TREE, 
displayed at the left, as well as in the chart. In addition it will display all 
formation in the WAVE INSPECTOR 
14. You may cruise the chart by clicking on the WAVE BUTTONS in the 
WAVE TREE. This will bring you to the required section in the chart, it will 
zoom in on this area and adjust detail accordingly. Alternatively, to zoom in, 
position your mouse pointer on empty space of the chart and press the 
RIGHT mouse button (not the left button) and a menu pops up which 
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contains the option Zoom in, select this and drag your mouse on the 
section of the chart  
15. To expand wave degrees, click on the + Button in the WAVE TREE, 
which are positioned in front of this wave degree. 
16. The preferred pattern is listed behind the WAVE BUTTON 
17. To make the WAVE TREE disappear select from View the option 
WAVE TREE, use this as a toggle for display 
18. By default the WAVE INSPECTOR will come up with complete 
information about the preferred pattern of largest degree, which is the top 
WAVE BUTTON of the WAVE TREE.  
19. If you press another WAVE BUTTON in the WAVE TREE, immediately 
the WAVE INSPECTOR will show information on the preferred pattern, 
found in this wave degree. 
20. It will show a standardized drawing of this pattern in the chart, 
presenting targets for this pattern and the path the pattern is expected to 
follow. 
21. On top of the WAVE INSPECTOR you will find two list boxes. The left 
box lists the patterns that have been approved, the right one that have 
been rejected. Select one of these patterns to see why patterns have been 
approved or rejected by inspecting the rules and guidelines that can be 
found in the WAVE INSPECTOR. 
22. Click on a rule or guideline in the WAVE INSPECTOR to visualize it in 
the chart. 
23. To make the WAVE INSPECTOR disappear select from View the 
option WAVE INSPECTOR, use this as a toggle for display. 
24. A summary of Trading Signal indications will appear automatically in 
the SUMMARY INSPECTOR provided the Trading Signals module has 
been ordered. 
25. To display indicators for the active chart, choose from the main menu 
Insert and select New Indicator pane. With your mouse select the indicator 
in the dialog box that pops up, Press the ADD button and Press OK. Some 
Indicators can only be inserted in the chart, choose New indicator in 
chart… 
26. The same way you can show the TIME CLUSTERS, provided the 
Target Clusters module has been purchased. 
27. If you like to use the other tools of ELWAVE as for example Channels, 
Fibonacci Pane and Quick targets, you will have to convert one of the 
alternatives of the automatic count to manual wave labels first. Select 
Analyze from the main menu and choose Convert to wave count. Please 
note that only the activated alternative will be saved in a separate window. 
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Hereafter you may save the scenario by choosing from the Scenario menu 
the option Save as… 
28. Loading a scenario containing manual wave labels, will not 
automatically display the WAVE TREE and WAVE INSPECTOR. In order 
to accomplish this you have to choose Check Wave count from the Analyze 
menu 
29. To display Fibonacci ratios of the selected wave label, choose from the 
main menu Insert and select Fibonacci pane. This will only work after you 
have converted to a wave count! And again you have to click on the wave 
label first to select it! 
30. To visualize more targets, select the wave label in the chart, press the 
right mouse button and choose Quick targets 
31. To drop channels, trend lines, spirals and the TIME RULER, grab this 
object in the CHART OBJECTS Toolbar on top of your screen and drop it 
on the wave label of your choice or at another position in the chart.  
32. In order to save all settings of the chart, including indicators, channels, 
targets etc. , save the scenario frequently. 
33. You are allowed to analyze multiple charts in several sessions of 
ELWAVE. 
34. If you have analyzed several charts, you can toggle display of the chart 
together with full analysis information by using from the main menu 
Windows and selecting one of the charts listed as menu items.  
35. To use the simulation feature (only available on purchase of Trading 
Signals), choose Options from the main menu and select Truncate price 
data… 
Before you choose this option, move the mouse pointer over the chart area 
where you would like to truncate the chart and watch the right end of the 
status bar for the index number, which has to be inserted in the Truncate 
dialog box. Truncate price data will force the software to neglect future 
data. Now instruct ELWAVE to analyze these truncated data and compare 
the analysis outcome and signals with what really happened in the future.  
For easy comparison future data has been grayed out in the chart window.  
36. Press CTRL-1 (or a higher number of the numerical keypad, NUM 
LOCK must be ON) to add future data to the price chart. If critical price 
levels get penetrated when adding future data, the ALERT INSPECTOR 
will show the trading indications automatically. 
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Batch Processing 
The ELWAVE BATCH PROCESSOR is a new and powerful addition to the 
ELWAVE suite of financial analysis products. Frequently recurring 
operations, such as analysis or printing of charts, can now be automated. 
The following dialog box will come up when you double click the Batch 
processing icon. 
Now you can define which charts you would like to have analyzed without 
the need to give the software every instruction by hand for every chart.  
You can only use previously defined Scenario files (extension *.ELW)!! 
Batch Processing Step by Step 
1. Define scenario files for each data file. Load the data file in ELWAVE 
and save it by choosing Scenario from the main menu and select the menu 
item Save. Repeat this for every data file you would like to include in the 
batch processing.  
Save these scenario files in a separate directory, so you can track them 
easily. 
2. If you have already defined a set of scenario files, press the ADD button 
to choose which scenario files to include. The above displayed dialog box 
will appear, cruise to the directory where your scenario files are located and 
select the files one by one or select multiple files by clicking the first 
scenario file, keeping SHIFT key pressed and clicking on the last scenario 
file with the left mouse button. After selecting scenario files click on the 
OPEN button. 
3.Alternatively you can drag scenario files from the Explorer into the 
BATCH PROCESSING dialog box. 
4. The BATCH PROCESSING dialog box will be filled with the selected 
scenarios. Behind each scenario files you will find the status of the 
analysis, which can be TODO, DONE, STOPPED. 
5. Now set other options you would like to have automated such as: 
Analyze chart 
Analyzing multiple charts automatically is the main purpose of batch 
processing so normally you would like to have this included. 
Print chart 
Check the Print chart option to print every chart automatically after it has 
been analyzed 
Save chart 
Check the Save chart option to save every analysis automatically for later 
inspection. 
Print target clusters 



 

 

67

Check the Print target clusters to also print the target zones with every 
chart automatically. 
Maximum number of ELWAVE instances to be used simultaneously 
You can start several sessions (increase the number) of ELWAVE, which is 
useful for computers running under NT equipped for dual processing. 
Otherwise it is advised to leave the setting at its default value. 
6. Press the SAVE or SAVE LIST AS… button to save the list of scenarios 
you have just defined to include with the batch processing. The next time 
you can easily retrieve the same list. Choose LOAD LIST… to do so. 
7. Press the START button to start the batch processing. 
8. Press the STOP button to halt the batch processing 
9. To remove a scenario from the list press the REMOVE button, to remove 
them all at once press REMOVE ALL 
10. If you press the RESET STATUS button the batch processing status 
will be reset to TODO 
Other information 
While the batch is being processed, it’s still possible to add new files by 
dragging them into the window or by using the ADD… button.  
While the batch is being processed, it’s also possible to remove all or a 
selection of files from the set. Scenarios that were being processed at that 
time are stopped before they are removed from the list. 
In addition, while the batch is being processed, it’s also possible to change 
the maximum number of instances that ELWAVE can use. For example: if 
you have a dual-processor system, you may want to run the batch 
processor with a maximum of one instance while you are still working on 
the system yourself, and switch the batch processor to ‘2’ when you are 
going home for the day, leaving the batch processor running. 
The ELWAVE Batch Processor can make use of up to 8 processors in a 
single system, provided enough memory is available. 
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Scanning 
The scanning modules come in two different versions, which are called 
SCANNING END-OF-DAY and SCANNING PROFESSONAL. 
This way the user can choose how much to add to ELWAVE. Of course 
THE SCANNING PROFESSIONAL is the most powerful module that works 
not only on end of day data, but on intra day data as well. 
Scanning, First Steps 
1. Start ELWAVE 
2. Choose View from the main menu and select Scan Inspector. The dialog 
box of the SCAN INSPECTOR will appear immediately as shown below 
 

 
3. If you are using the SCAN INSPECTOR for the first time, use the 
predefined list to define the items to include in the scan lists. Please note 
that you can make as many scan lists as you like. Select the EDIT button 
next to SCAN LIST in the upper left corner to add items to your list 
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4. The following SCAN LIST dialog box will appear: 

 
 
5. Select the NEW button, which will make appear another dialog box to 
input the name of the list you would like to make; 
6. Press OK and next the ADD button from the SCAN LIST dialog box to 
add items to your scan list and repeat this process if you would like to add 
more lists. 
7. Cruise to the directory that contains the data files of the items you would 
like to include 
8. Select the items to include, please note that you can add multiple items 
by using the special Windows SHIFT and CTRL key combinations. Select 
the first item on top of the screen in the Open dialog box, scroll down to the 
last item and select it while keeping pressed the SHIFT-key to select all 
items at once. 
9. Press the OPEN button to return to the SCAN LIST dialog box 
10. Press the CLOSE button to return to the SCAN INSPECTOR dialog box 
11. Select the EDIT button at the RIGHT upper corner that belongs to 
Conditions 
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.  
 
12. Now the EDIT SCAN CONDITIONS dialog box comes up, where you 
can define the criteria to scan for. Below you will find an example from the 
SCANNING END OF DAY 
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13. Press the NEW button to name your conditions set and start entering 
criteria by moving the mouse to the field you would like to specify. 
14. Select CLOSE once you have finished entering criteria, which will 
return you to the SCAN INSPECTOR dialog box 
Press the SCAN NOW button to start scanning your list for the criteria 
selected. 
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Automatic Analysis 
NOTE: In case the Trading Signals module has been included in the 
software package, ELWAVE will make a full automatic interpretation of the 
remaining Elliott alternatives and display the results in the SUMMARY 
INSPECTOR. 
 
ELWAVE will list the most probable outcome as the very first alternative. 
Alternatives that contain very little detail should be dismissed, if they 
appear at all.  
You will notice that alternatives are ranked according to their probability, 
taking into account the probability of the occurrence of a pattern, the 
Fibonacci ratios, the scores of the sub patterns and so on. A more detailed 
description can be found under the experts’ section. 
If most alternatives, that remain with respect to the same time frame (every 
wave degree is a time frame!), indicate the same price direction, we 
encounter a strong probability that prices will move in the direction of the 
forecasted trend. In case - with respect to the same time frame- half of the 
alternatives indicate rising prices and half of these predict lower prices, 
obviously there is no interesting trading opportunity at hand. 
Still you have to inspect thoroughly the different alternatives that are 
available. You can inspect alternatives on every wave degree level by 
clicking with the right mouse button on the WAVE BUTTON. A dialog box 
will appear where you can select the previous and next alternatives. The 
alternative that has been numbered 0, has the highest score. Especially 
unfinished, mostly extended waves could not (yet) have the highest score, 
because relatively fewer data is available compared to finished waves. 
Obviously finished waves for example could contain more Fibonacci ratios 
and therefore have a higher score, which the unfinished wave could get as 
soon as it is more complete. 
Still the unfinished waves could be a very probable outcome. For experts it 
is advised to sub label every LAST unfinished wave of all unfinished waves 
as deep as possible to see if the alternative still holds and how it scores. 
Do the same with other alternatives and compare the outcome. 
In order to accomplish this you could start with a FAST automatic analysis, 
see Analysis options dialog box, select the last unfinished wave in the 
WAVE TREE and choose Analyze Selected Wave from the Analyze menu. 
Just take a look at the picture in the Targets section following, to get the 
general idea. 
Alternatively you could insert the main wave labels yourself and start from 
there generating an unfinished wave every time, see the Experts 
information section.  
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Besides, you could try the different Analysis options to compare their 
results. The more detailed the results the fewer counts will be available. 
Please pay attention to the following. In general the most detailed chart, 
which has labeled more wave degrees, without generating an internal wave 
structure violation, is the most probable outcome. If there are other less 
detailed alternatives, try to analyze these further down (more wave 
degrees) step by step.  
If the analysis comes up with a finished wave as the most probable 
outcome, always inspect if there is an unfinished alternative and compare 
wave detail, scores as well as the sub scores that these scores are 
composed of. 
Furthermore the software will present the following: 

• a list of alternatives, the main alternatives of the highest wave 
degree will be displayed as buttons right above the WAVE TREE, 
click on the button and the wave analysis will appear in the chart 
window 

• a summary of results of a pattern in the WAVE INSPECTOR 

• the most probable targets based on Fibonacci ratios, taking into 
account that targets differ for each pattern and each wave within a 
pattern, see below 

• a path of expected price action for the pattern under investigation. 
By selecting the pattern in the WAVE INSPECTOR, ELWAVE will 
show the pattern (using the color of the wave degree), the TARGET 
BARS (using the color of the wave degree) and the SWING FILTER 
in the chart (the light blue line). The pattern also presents one most 
common target for each wave to be reached, based on the ratios of 
already completed waves within the pattern. 
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Targets 
As mentioned before targets will be automatically displayed when the chart 
has been analyzed by either choosing Analyze entire chart, Analyze 
selected wave or Check wave count, provided you have switched on the 
display of targets in the WAVE INSPECTOR options. Only targets of 
unfinished or incomplete waves are projected!  
These unfinished waves display a gray cross in the WAVE BUTTONS of 
the WAVE TREE. 
These targets are represented in the TARGET BAR , which display the 
expected range of the pattern under investigation as a vertical line.  
 

 
On the vertical line you will notice small horizontal lines, which are the most 
probable targets based on Fibonacci price relationships. The positioning of 
the target bar at a specific point of the Time (or X-) axis is not relevant.  
If 5 wave degrees are unfinished as in the example depicted above, 5 
target bars will appear, each in the color of their respective wave degree.  
The more these target bars converge to the same range and cluster of 
targets, the more likely the targets are. 
Of course targets can still be inserted as before by selecting a wave label- 
provided you have converted the analysis to manual wave labels-, clicking 
the right mouse button and choosing Quick targets. 
ELWAVE will insert channels automatically in a smart way, depending on 
the progress of the pattern. 
 
Elliott Wave Model 
Below we will give some information on the Elliott Wave model used to 
generate an analysis automatically. 
First of all we would like to emphasize that our software uses a true Elliott 
Wave model that incorporates every aspect as required by the Elliott Wave. 
The secret of the Elliott Wave is the patterns in patterns concept, which is 
fully supported in the software. We mention the following: 
Fractals  
As described in a later chapter of this manual, Elliott has discovered that 
price fluctuations and market action are of a fractal nature. Fractals are 
mathematical structures, which on an ever smaller scale infinitely repeat 
themselves. The patterns that Elliott discovered are built in the same way. 
An impulsive wave, which goes with the main trend, always is composed of 
five waves. On a smaller scale, within each of the impulsive waves of the 
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before mentioned impulse, again five waves will be found. In this smaller 
pattern, the same pattern repeats itself again and so forth. 
Of course this fractal nature enabled us to program the Elliott Wave. The 
ever and ever repeating structures or patterns in prices, which are limited in 
number, makes it possible to detect which pattern most probably applies 
and in which direction the market is headed. 
We have defined all standard patterns plus patterns we have discovered in 
our extensive research and years of experience (see chapter , the Elliott 
Wave Principle.), which have been implemented in our “Modern” rules. 
Basic patterns 
The Elliott Wave allows for predefined patterns only. This means that only a 
limited number of patterns can occur in price charts, each pattern having its 
own unique characteristics. 
Meticulously, we have defined all these patterns in our rules. Once an 
analysis has been generated or checked, you can inspect all the rules and 
guidelines that belong to a specific pattern. 
 
Internal structure 
Internal structure refers to the internal wave structure or patterns of a 
pattern. (Sub)Waves of a pattern may consist of permitted patterns only!. 
For instance an impulsive wave 3 can never contain a zigzag pattern, if this 
occurs the internal structure of wave 3 is incorrect and therefore the pattern 
to which wave 3 belongs is incorrect, and its higher pattern is incorrect and 
so on… 
In our rules we have defined which patterns are allowed for each wave. 
For example, the second or B wave of a flat is allowed to contain a Zigzag, 
but not a Triangle, while the 3rd or C wave of a Flat can have an 
Extension3 but not a Zigzag pattern. 
Proportions 
In order to group waves that belong to the same degree, together building a 
larger degree pattern, proportions of waves are essential.  
Obviously waves of the same degree must approximately have the same 
objective measurements in time and / or price. For this purpose we have 
developed our proprietary “Fibonacci proportions”, that closely work 
together with our home made SWING FILTER, which identifies the major 
turning points for every wave degree. 
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Below we first will give an example of wrong proportions and therefore an 
incorrect wave count: 

 
Wave 2 is far too small to be of the same degree as wave 4. Using such a 
method of counting waves will make it possible to come up with every wave 
count imaginable. Unfortunately this aspect seems to be very difficult to 
assess objectively. No longer using ELWAVE, which will do an objective 
and consistent analysis, recognizing patterns correctly as in the example 
below, where wave 2 and wave 4 do belong to each other: 

 
 
Other selection criteria 
Furthermore we mention some of the other criteria that have been used to 
determine the wave count: 

• waves must have enough data points of at least 8 to make it 
possible to define a pattern at all 

• of the different types of patterns possible in a wave, only the best 
pattern will be maintained. If for example in a wave several impulses 
and Extension3 are validated, only the best impulse and the best 
Extension3 will be listed 

• in an extended wave where a wave 1 and wave 2 again is followed 
by a wave 1 and 2 of lower degree, at maximum sub wave 1 can be 
a little longer than its parent wave 1 
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• apart from the checks visible in the WAVE INSPECTOR, several 
proprietary checks have been implemented to determine the validity 
of a wave count 
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Ranking Alternative Wave Counts 
In order to rank alternatives ELWAVE determines the probability of 
alternatives that have been validated. Patterns that remain, have a correct 
internal structure and satisfy every rule as defined in all sub patterns and 
waves. 
The scores or probability of every pattern have a relative significance. If 
scores of patterns are more or less the same (difference of less than 5 
points), they should be regarded to have a more or less equal probability.  
A score above 40 should be regarded as relatively high, while a score 
under 20 makes a pattern less likely. Of course these scores can still 
increase as the pattern progresses. 
Every validated wave count gets a score that, among other factors, takes 
into account the following: 

• general probability of the occurrence of patterns, for example one of 
the most frequent encountered patterns is an Extension3 (Extension 
in the 3rd wave) 

• probability of the occurrence of patterns in a particular wave, f.e. a 
Zigzag in a wave 2 is very common, but less likely in wave 4 of an 
impulsive pattern 

• Fibonacci Proportions, the more waves have the same 
measurements, the better their scores 

• Fibonacci Time ratios, the more and better Fibonacci time 
relationships can be found, the higher the score 

• Fibonacci Price ratios, the more and better Fibonacci price 
relationships can be found, the higher the score 

• guidelines, the more guidelines are satisfied, the higher the score of 
a pattern 

• scores of sub waves and sub patterns, the better sub waves of a 
wave score on all of the above mentioned aspects, the higher the 
total score. 
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Inspecting Alternative Wave Counts 
On every wave degree alternative wave counts can be inspected. The main 
alternatives of the highest wave degree or time frame are listed in the 
WAVE TREE. In order to investigate alternatives of sub waves, click on the 
WAVE BUTTON in the WAVE TREE and expand the WAVE TREE if 
necessary. Next click with the right (not the left!) mouse button on that 
WAVE BUTTON and a list of alternatives for this wave will appear. 
Selecting one of these alternatives will display the alternative in the chart. 
This can be repeated for every wave that has been listed in the WAVE 
TREE. Remember that always the best alternative on every wave degree 
will be listed on top. 
Nevertheless it could be possible that a less probable alternative wave 
count or pattern ends up to be the one markets are following. 
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Multiple Time Frames 
As known to experienced traders, each time frame has its own 
characteristics such as trend, volatility and momentum as well as support 
and resistance areas. The shorter the time frame you are able to assess 
correctly, the earlier you will get signals for the larger trend of which the 
shorter trend takes part. 
Obviously you need to inspect multiple time frames using a consistent and 
objective methodology. That is exactly one of the strengths of the Elliott 
Wave provided it is applied correctly. 
 
The Elliott Wave is nothing but clearly picturing multiple time frames, since 
it is composed of patterns in patterns, where the shorter-term patterns give 
precious information on the larger pattern in progress and every pattern 
from small to large covers a specific time frame. 
What’s more, using its SWING FILTER ELWAVE will automatically group 
waves together that belong to the same time frame, which in Elliott Wave 
terms are referred to as wave degrees. 
 
ELWAVE includes an Automatic compression option, which is very 
convenient to use in conjunction with the WAVE TREE. If you disable 
automatic compression the WAVE TREE will no longer clearly present the 
attached time frames. 
 
Thereby ELWAVE automatically finds the time frames or wave degrees that 
are of value in a particular price movement. Normally a trader has to try 
multiple time compression settings from monthly to weekly, daily, hourly, 15 
minutes etc., in order to find the time frames that apply, being aware of the 
fact that time frames vary from time to time. 
The wave degrees ELWAVE will come up with, will show the multiple time 
frames that are in existence for this market or stock. Activating the highest 
wave degree, by clicking on the WAVE BUTTON of the pattern of largest 
degree in the WAVE TREE, will show the largest trend or time frame 
immediately. Clicking on one of the buttons of the sub waves of this pattern 
will present the lower time frame and so on, down to the smallest time 
frame in existence. 



 

 

81

Converting Automatic Wave Counts to Manual Counts 
You can convert the selected alternative from the automatically generated 
wave counts by choosing Convert to Wave Count from the Analyze menu.  
The manual wave count will appear in a separate chart document. You can 
convert to a manual wave count as many times as you like. In order to save 
an alternative as a scenario, choose from the main menu File and select 
Save as to save the wave count as a scenario. 
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Analysis Options 
You can adjust important variables that determine the outcome of an 
Automatic analysis, by changing the default setup. Select one of the 
presettings presented. 
The following settings are available (version 6.0): 
Pattern definitions 
You can choose either the CLASSIC or the MODERN RULES version. The 
Classic version adheres to a very strict interpretation of the Elliott Wave  
Analysis Type 
By choosing one of the presettings you will set the detail of the SWING      
FILTER as well as the analysis depth or number of wave degrees to 
inspect. The SWING FILTER will search for major turning points for every 
wave degree, grouping waves of the same degree together.  
If you instruct ELWAVE to use a more detailed analysis, the SWING 
FILTER will find more turning points automatically, revealing more 
variations of possible wave counts. By default the SWING FILTER (pale 
blue line) will be shown in the chart by clicking on a button of the WAVE 
TREE, select pattern in chart in the WAVE INSPECTOR for switching it on 
or off.  
FAST  
this will produce a wave count of three wave degrees very fast using a 
SWING FILTER that identifies the major turning points only. 
DETAILED 
again a three wave degrees deep analysis is produced, but this time the 
SWING FILTER will search for a lot more turning points (around 8) at the 
highest wave degree level. This option produces many alternatives and we 
advise this to be used by experts only, who can eliminate alternatives 
themselves. 
PRECISE 
using this setting a detailed SWING FILTER will inspect patterns four wave 
degrees deep and use a lot more turning points to inspect many more 
alternatives. 
 
Below an example of an analysis depth of 3 wave degrees in wave 3 is 
shown. The pattern is called an Extension3 since the 3rd wave is extended. 
This pattern must consist of 5 waves, which is correct. 
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Extra wave degrees 
Adjusting this option allows for automatically adding extra time frames or 
wave degrees during the analysis. It will analyze the most recent price data 
in more detail giving more information on the smallest patterns in patterns. 
The more extra time frames you require, the more time it will take to 
complete the analysis. 
Minimum Bars 
Enough bars or data points must be available in order to recognize reliable 
Elliott Patterns. If Minimum bars has been set to 20, the software will return 
an undefined pattern if it encounters less then 20 bars in a pattern. We 
recommend setting this option to 8 bars for End of Day charts. Of course 
ELWAVE will allow you to adjust settings in order to get results faster, 
detect more complicated patterns or to get a more detailed result. 
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Analysis Example 
In this section we will give another example of generating an Automatic 
analysis. 
Once an analysis has been generated the WAVE TREE, the WAVE 
INSPECTOR and the chart with its current wave count will be displayed. 
Now it is possible to further inspect and analyze the wave count that has 
been generated. Click on a WAVE BUTTON in the WAVE TREE to inspect 
and display that section of the chart. The chart will zoom in and display 
correct detail automatically. The WAVE INSPECTOR will give a lot of 
information on the wave or pattern selected. On top at the left, the WAVE 
INSPECTOR will show validated patterns at the right dismissed patterns. 
Both can be inspected, as you like.  
Click on the pattern to display all information in the WAVE INSPECTOR, 
which feature makes the Elliott Wave completely transparent. The pattern 
has been described, the internal structure of the pattern has been checked, 
all Fibonacci ratios are presented and rules as well as guidelines can be 
inspected. Clicking one of these rules or guidelines will visualize it in the 
chart. 

 
For more information, see the next chapter, where WAVE TREE and 
WAVE INSPECTOR have been explained in more detail. 
 



 

 

85

Analyzing Waves 
Analyzing Finished Waves 
Suppose ELWAVE has completed an analysis and after inspection of the 
alternatives produced, you would like to analyze some wave in more detail. 
You may want to analyze Finished (completed) as well as unfinished 
(incomplete) waves, but let us first start with Finished waves. 
A finished wave is a wave that contains a completed pattern; every wave 
within the pattern has been found and determined. See the following ABC 
completed wave. 

 
Now suppose we would like to analyze it more detailed and see if the 
internal structure still supports the pattern found.  
We can now analyze the C portion of the wave by selecting it in the wave 
tree and then analyzing the selected wave. This will produce more detail.  
Analyzing Unfinished Waves 
This can be accomplished in exactly the same way as with finished waves. 
An unfinished wave is the last wave in progress marked by a gray cross in 
the WAVE BUTTON. Select this wave in the WAVE TREE and choose 
Analyze selected wave from the Analyze menu. 
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Using your Own Wave Count 
Of course you can label a chart yourself and then have ELWAVE analyze 
any section you like, which enables you to take shortcuts. We will give a 
simple example below.  
 

 
Just drop wave (IV) on the low you would like to determine as the end of 
wave (IV) and the beginning of wave (V).  
The next step is to choose from the main menu Analyze and select Check 
Wave count. A WAVE TREE will be generated, just neglect the patterns 
that appear next to the WAVE BUTTONs, because these have no added 
value, since only one wave label has been inserted. 
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Now we will analyze the unfinished wave (V). To produce this analysis, 
select wave (V) in the WAVE TREE.  

 
 
Then choose Analyze selected wave as explained under Analyzing 
Unfinished waves. 

 
In case you would want to test if wave (V) could already be finished, insert 
wave V at the current top, choose Check wave count, select wave (V) in 
the WAVE TREE and generate an analysis. 
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You would then get the following tree pattern, 

 
 
and the following chart labels. 
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Introduction to Trading Signals 
The Trading Signals module now provides full automatic detection of trading 
opportunities. Please note that the Automatic Analysis module is required.  
Attention: 
You will need the special “Trading Signals” module to have available full 
automatic trading indications. 
 
The “Trading Signals” module will make life a lot easier by interpreting 
remaining Elliott alternatives for you. It presents a summary and it will give 
clear entry and exit indications as soon as trading opportunities emerge, 
even in real-time if required. In addition, a SUMMARY INSPECTOR will be 
presented containing essential information. 
As soon as critical levels are broken, the software will show signals, update 
the summary and, if required, even update the analysis partially. Partial 
reanalysis will save precious time compared to a full automatic analysis, 
thereby facilitating intra day analysis of a very complex and demanding 
method as much as possible. However, an entire analysis will always be 
more precise than just updating the analysis. 
Our trading signal indications, which are slightly different for the CLASSIC 
and MODERN RULES, are no black box mechanical system that should be 
used in blind trust. You will have to familiarize yourself thoroughly with the 
outcome, the interpretation and the circumstances that make particular 
signals useful.  
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Disclaimer 
The Customer acknowledges and agrees that neither Prognosis Software 
Development (Owner), nor its employees, make any representation or 
guarantee regarding how this product may perform in the future, nor will this 
product guarantee profits for the Customer. The Customer is advised to test 
the software thoroughly before relying upon it. The user accepts to assume 
the entire risk of using the software. In no event shall Owner be responsible 
for any special, consequential, actual or other damages, regardless of type, 
and any loss or lost profit resulting from the use of this software or printed 
material. Customer acknowledges that success depends upon Customer’s 
ability to utilize the information, software and techniques described in this 
product. Customer’s payment, returning of the registration card or signature 
shall be evidence of Customer's acceptance of all of the License 
agreement. 
Although many strategies are possible, we would still like to mention 
common misperceptions some may have using the Elliott Wave. Obviously 
these have been caused either by the complexity of the Elliott Wave or by 
human nature, always searching for the perfect system. 
Some people think Elliott Wave comes up with too many alternatives: 
exactly this is the complexity of the Elliott Wave, not only to see the big 
picture as well as how to fit the smaller patterns into this big picture, but 
also to understand how and under what circumstances different alternatives 
support each other within the same time frame or, even more difficult, using 
several time frames at once. 
This is exactly the way ELWAVE determines trading opportunities. Although 
it selects alternatives that have high probability first, it does not try to 
pinpoint the one and only possible alternative. It just forecasts the trend as 
a composite picture of all alternatives!! The moment an up or down trend 
has been confirmed, the software will signal this. 
Some people think Elliott Wave should be used for picking highs and lows: 
The Elliott Wave is possibly the best method to pick tops and bottoms, but 
this requires expert knowledge and experience. Apart from that, it is always 
possible that a trend extends under specific circumstances; so taking 
counter trend positions by picking tops and bottoms is more risky.  
The Elliott Wave is even more reliable, if used to signal trading opportunities 
at cross points. At cross points, penetration of critical levels could cause 
virtually all alternatives to suddenly forecast one price direction and trading 
opportunities do emerge with a very high probability and a relatively very 
tight stop. 
Naturally such a trading strategy will be more rewarding in the long run, 
than just hoping to pick a top or low exactly, not having a clear stop and 
incurring the (high) risk of missing a lot of the trend in progress. 
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Summary Inspector 
Trading signals get most powerful if used together with the Automatic 
Analysis. After completion of the Automatic analysis, all relevant signals will 
be collected, sorted and automatically summarized in the SUMMARY 
INSPECTOR. 
The SUMMARY INSPECTOR will show each time frame or wave degree 
that has been analyzed. By default the “FAST” analysis will show results of 
3 consecutive time frames, always starting with Supercycle degree.  
We explain the columns of the SUMMARY INSPECTOR below: 
Time frame 
In the TIME FRAME column the name of the wave degree appears in the 
same color as the wave labels in the chart. Although the wave degrees 
carry the names as used in the Elliott Wave Theory, they do not relate to 
the time period that normally has been assigned to these wave degrees. 
The largest trend or highest degree pattern is listed on top followed by the 
smaller wave degrees, which build the larger trend or pattern.  
EASI 
The column EASI tells if this market or stock still should be bought or sold. It 
has three possible readings, which are Positive, Negative or Neutral.  
In case the Risk / Reward is negative, but the trend is still up, it will indicate 
to Hold positions (= Neutral) until the first Exit has been encountered as 
specified in one of the next sections. In this case the last price will have 
traveled beyond the TARGET, which has turned negative, indicating targets 
have been reached and risk is increasing. But in view of the fact that very 
often Extensions occur, it is advised to wait for an Exit signal to reverse 
positions. 
If the R/R is positive and the trend is up it will give a positive indication, if 
the trend is down it will give a negative indication. 
Sometimes the highest scoring alternative may conflict with the EASI result 
as shown in the SUMMARY INSPECTOR. For example, a complete 
uptrend could have been labeled while the SUMMARY INSPECTOR still 
gives a positive indication! Although theoretically the uptrend could be 
complete, obviously the composite picture of all alternatives clearly tells you 
not to try to pick this top. Only when all or most trends support each other 
pointing in the same direction, normally an opportunity emerges. 
 
Trend 
The Trend Column clearly indicates the trend - up or down - that has been 
detected for each time frame. Sometimes both an uptrend as well as a 
downtrend has been discovered, which means alternatives do not agree 
upon the future trend. Naturally in this case the EASI column will be Neutral, 
since we do not yet know where prices will go.  
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Target 
This column represents the expected weighted reward of all alternatives per 
time frame and serves as a sort of minimum target. If a trend is recognized 
early, one could take advantage of a very interesting trading opportunity, 
giving a high reward and relatively low risk. This target has been calculated 
rather conservatively and will normally be reached. When the price moves 
continues, first the TARGET will become negative, because the average 
expected target has been exceeded. Later on, again the TARGET could 
become positive due to the elimination of patterns that have a much lower 
expected target. The TARGET is displayed in the chart for every time frame 
using a diamond symbol. 
% 
The percentage expected return derived from the TARGET and current 
price. 
Exit 
This is the price at which the very first critical level gets broken, indicating to 
reverse the current position. This exit is very conservative and defensive, 
because possibly just one of the remaining patterns could have been 
eliminated and still other alternatives are in existence. It is advised to run an 
Entire analysis before acting upon this exit. The EXIT is pictured for every 
time frame using a small triangle symbol in the same color as the time 
frame. 
Reward 
This is the number of points calculated by the TARGET minus the current 
market price. 
Risk 
The RISK is pictured in the next column, displaying the number of points 
until an exit would get triggered. Please be careful an do NOT rely upon 
risks that are relatively very small and lead to high R/R’s. 
In our view it is not the one and only outcome that one should try to find, but 
what really matters is the accumulated result of all alternatives. If most 
alternatives indicate an uptrend this is much more likely to happen than just 
selecting one alternative as THE one and only outcome 
 

Alert Inspector 
Inspection of and understanding signals requires much more knowledge of 
the Elliott Wave. Nevertheless studying these facilitates learning the Elliott 
Wave more easily, but it will take time and you need to practice. 
The ALERT INSPECTOR will appear as soon as critical price levels have 
been triggered. This could happen when new End-of-Day or intra day data 
have been appended to the data files or when a real-time feed has been 
activated. 
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This will also appear when using the powerful simulation feature for which 
the Trading signals module is required.  
Alternatively the ALERT INSPECTOR can be displayed by selecting View 
from the main menu and choosing ALERT INSPECTOR. 
By default a summary of the signals will appear on top of the window. 
ELWAVE presents the number of positive indications or negative indications 
per time frame. If the positives significantly outnumber the negatives on a 
specific time frame, the picture of course foretells a rising market, provided 
the outcome of the SUMMARY INSPECTOR agrees upon the same trend. 
Clicking on the DETAILS button will show all signals, which can give 
important additional information to take into account. 
Remember that the outcome as presented in the SUMMARY INSPECTOR 
is most important. Sometimes at first sight the (number of ) signals could 
give a conflicting message. 
The following should be taken into consideration when studying the signals: 

• determine the time frame you will use for your investment first 

• check the outcome of the summary, if the summary displays a 
negative for a time frame and positive signals are presented in the 
ALERT INSPECTOR, it is risky to start buying already, however it 
could be an early warning for a trend change.  

• compare the number of positives versus the number of negatives for 
each time frame. The strongest indication is when no conflicting 
signals are given. 

• take a look at the patterns for which signals have been generated, 
trend (especially Extensions) and Zigzag patterns are the most 
reliable to trade 

• take a look at the wave of the pattern, wave 3 is the most interesting 
and reliable wave 

• Although ELWAVE will automatically reanalyse, it is advised to start 
a new, entire analysis from time to time, especially when conflicting 
signals have been encountered.  

• check the description of the signals: 

• most signals go with the trend and confirm that the trend is in 
progress. 

• There is one exception though, the description “Most often the 
second wave retraces from around 50% to 62%” refers to a signal 
that goes against the current trend and therefore is more risky. 
Signals based on this rule have great potential, but should be 
carefully considered. If at the same time conflicting other signals 
come up, its significance is diminished. In addition, preferably the 
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trend of the higher wave degree should support the direction (up or 
down) of the lower trend and it must be a wave 2. 

• Check the type of signal as for example Entry buy or Exit buys as 
explained below. 

• Now we will explain the ALERT INSPECTOR in more detail. Below 
we will first show an example of the summary in the ALERT 
INSPECTOR: 

Pressing the DETAILS button will list the trading indications that have been 
triggered as demonstrated below: 
The ALERT INSPECTOR can show the following signals, remember that 
the SUMMARY INSPECTOR is the dominant factor: 
Entry buy 
this signals that positive alternatives have been confirmed and is the 
strongest positive indication. Normally the SUMMARY INSPECTOR too will 
show a Positive for this particular time frame. 
Exit buy 
this signals that minimally one negative alternative has been dismissed. It 
should be considered to be a less strong positive indication, because other 
negative alternatives could still be in existence. Check if the SUMMARY 
INSPECTOR shows a Positive too for this particular time frame. Normally 
this is an early warning signal for a trend reversal. 
Entry Sell 
this signals that negative alternatives have been confirmed and is the 
strongest negative indication. Normally the SUMMARY INSPECTOR too 
will show a Negative for this particular time frame. 
Exit Sell 
this signals that minimally one positive alternative has been dismissed. It 
should be considered to be a less strong negative indication, because other 
positive alternatives could still be in existence. Check if the SUMMARY 
INSPECTOR shows a Negative too for this particular time frame. Normally 
this is an early warning signal for a trend reversal. 
 

Target Clusters 
Attention: In addition to the Basic module, you will need to have purchased 
the Automatic as well as the Trading Signals module to be able to use the 
Target Clusters. 
The TARGET CLUSTERS module now features time and price targets 
based on Fibonacci relationships. Very powerful research tools have been 
included to project probable turning points in time as well as price. 
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In an indicator pane TIME CLUSTERS can be added as an indicator, just 
like other indicators. In addition a so-called TARGET ZONE can be shown 
in the chart when an automatic analysis has been completed. 
Time Clusters 
Although ELWAVE has supported a time tool from the beginning, which is 
the GOLDEN RATIO TIME RULER, we have now implemented a faster and 
almost automatic way of finding interesting reversal points in time. 
Finding valuable time targets still is one of the most difficult and time 
consuming things to accomplish. One of the best methods is to use 
Fibonacci time relationships and project future dates where a lot of these 
relationships coincide around or near the same date. 
The arrow in the picture above is located at a point in time where at least a 
reversal of some importance is likely, because at that point the cluster bars 
are the highest. 
Please note that only future dates beyond the last price data will be shown 
by TIME CLUSTERS. Therefore no TIME CLUSTERS will appear when you 
have zoomed in upon a small part of the chart that does not include future 
dates beyond the end of the data file. 
The TIME CLUSTERS indicator supports two types of clusters, both based 
on projections of Fibonacci ratio relationships. The first type uses the 
patterns as found by the Automatic Elliott Wave analysis, the second type 
uses a user-defined swing filter. This will be explained in a later section of 
this chapter. 
To assess if an important turning point is around the corner, in general we 
advise to check the following: 
The higher the bars in the TIME CLUSTERS indicator pane, the more 
Fibonacci TIME CLUSTERS come together at one point in time. 
The more wave degrees or trends, depicted by different colors of the 
clusters, support these clusters the more important it gets. If for example a 
high cluster bar is only supported by one color, it should be considered as 
weak or only a very short-term indicator. If the larger time frames support 
the cluster bar too, it should normally be a more important indication and 
could become a reversal of larger degree. 
Because the shortest trend projects the most turning points and does so 
nearby the latest price action, the cluster bars tend to be higher at the start 
of the projection, just beyond the end of the data. Normally high peaks that 
show up much later in the future are more important and therefore should 
be watched carefully. 
You can choose to connect only highs, only lows or any combination. This 
way you can research if for example projecting only Fibonacci ratios of 
market lows will project the next important low. This should be expected, 
however, when you have found a focal point in time, where a lot of 
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Fibonacci ratios coincide backward and forward, alternation could show up 
and project the next high instead of a low. 
Try different zooming positions when looking at the TIME CLUSTERS and 
compare their results, because ELWAVE will only use the price data that is 
visible in the chart window. If you have zoomed in upon a small area, only 
Fibonacci ratio relationships of that particular data will be used to calculate 
TIME CLUSTERS. 
Use the simulation feature to determine how to read the TIME CLUSTERS 
and which settings to use. 
Time Clusters Settings 
Just like ordinary indicators, you can insert the TIME CLUSTERS by 
selecting Insert from the main menu and choosing Insert indicator pane.  
 
Select TIME CLUSTERS, click on the ADD button and the next dialog box 
will pop up where you can adjust settings of the TIME CLUSTERS.  
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Patterns 
Include all patterns 
If this option has been checked, time targets of all patterns that still have 
been validated on every wave degree will be included in the projection. If 
this option has been set to off (unchecked) only the time targets of the 
currently selected pattern will be calculated. 
Include all alternatives 
If this option has been checked, time targets of all validated alternatives on 
every wave degree will be included in the calculation. If this option has been 
set to off (unchecked) only the time targets of the currently selected 
alternative and their sub selections will be calculated. 
Include finished waves 
In case this option has been selected, Fibonacci time targets of finished or 
completed patterns, that normally have no relevance to a pattern in 
progress, will be calculated too. Therefore by default this option has been 
set to off, however it still could be valuable to research if completed patterns 
are of any importance. 
In addition, if this option is set to off, ELWAVE automatically will make a 
selection to only include alternatives of which trading signals have been 
triggered and really matter. 
Filter based Time Clusters 
Filter 1 Here you can define the number of turning points for the first swing 
filter that it will take into account for the calculation of TIME CLUSTERS. 
The fewer the turning points, the larger the trend or waves that are used 
and the fewer clusters appear. 
Filter 2 See above. You can choose to define a second filter with for 
example a lot more turning points to discover smaller degree reversal 
points. 
Filter 3 See above. You can choose to define a third filter with a lot more 
turning points to discover smaller degree reversal points again 
Change color  
You can change the color of the swing filter that will be shown in the chart. 
Connect highs with highs 
If this has option been checked, the distance in time between every two 
consecutive highs will be measured and Fibonacci ratio relationships as 
defined under Ratios will be projected. Normally this option is used to 
project future highs. However because highs and lows sometimes tend to 
alternate, it could be interesting to research if this option is also valuable to 
predict future lows. 
Connect highs with lows 
If this has been checked, the distance in time between every two 
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consecutive high and low will be measured and Fibonacci relationships as 
defined under Ratios will be projected. 
Connect lows with lows 
If this has been checked, the distance in time between every two 
consecutive lows will be measured and Fibonacci ratio relationships as 
defined under Ratios will be projected. Normally this option is used to 
project future lows. However because highs and lows sometimes tend to 
alternate, it could be interesting to research if this option is also valuable to 
predict future highs. 
Show filters in chart 
If this has option been checked, ELWAVE will show the swing filters in the 
chart in order to see yourself what turning points, highs and lows have been 
used for the calculations. 
Show degrees accumulated 
If this has option been checked, the software will make a total of clusters 
instead of picturing every wave degree or trend separately. 
Ratios 
By default the most common ratios have been defined. You can add or 
change the ratios as you like. 
Restore defaults 
Press this button to restore default ratio settings as set by Prognosis. 
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Target Zone 
This exciting new feature combines both price and time Fibonacci ratio 
relationships to project not only an expected PATH of price direction, but 
also to visualize hot TARGET ZONES where prices are expected to travel 
to. 
Although time Fibonacci ratios between waves do occur frequently, 
normally for example an explosive wave 3 will take only a fraction of the 
time to complete wave 1. Obviously in such a case often no Fibonacci 
relationships exist. 
Nevertheless other relationships, that combine price and time Fibonacci 
ratios, do apply and can be used to project hot spots where prices are 
expected to meet resistance. If these zones get penetrated, normally the 
price could travel to the next target zone. 
The PATH in the chart shows the bandwidth that is expected to contain the 
price movement. 
The (red) hot spots in the chart are the so-called TARGET ZONES. The 
more targets come together in the same area the more red this target zone 
will become. 
Definitions of Fibonacci ratios of the TARGET ZONES have been 
preprogrammed in ELWAVE and cannot be changed. Other settings of the 
TARGET ZONES can be changed by selecting Options from the main menu 
and next choosing the menu item Target Zones. Below we will explain the 
settings in more detail. 
 
Target zone settings 
These settings can be subdivided in two sections: 
Cluster calculation settings 
These settings are specific to each scenario, therefore every scenario can 
contain different settings. 
Include all alternative wave counts 
If this option has been checked, the TARGET ZONE will be calculated using 
every still validated alternative and pattern. In addition, only the TARGET 
ZONES of unfinished waves will be calculated, not of finished waves or 
completed patterns. 
Currently selected wave count 
If this option has been checked, the TARGET ZONE will be calculated only 
for the wave count that has been selected.  
Include all patterns 
If this option has been checked, the TARGET ZONE will be calculated using 
all different patterns that are still possible in the wave count under 
investigation, not just the selected pattern. Patterns can be selected in the 
WAVE INSPECTOR, choose from Analyze the menu item Expert layout to 
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display the WAVE INSPECTOR alongside the chart. All patterns listed in 
the left box on top of the WAVE INSPECTOR will be taken into account. 
Of course patterns listed in the right box will not be included because these 
patterns have been invalidated. 
Include sub waves 
If this option has been checked, TARGET ZONES of completed patterns or 
finished waves will also be displayed. At a glance this will give you 
information how the target zones did fit historically for the selected pattern. 
Exclude targets exceeded by…% 
Here you can choose to exclude targets that exceed a user-defined 
percentage. Targets above or below a certain percentage market price 
could be less relevant to the shorter-term trader and distort the picture. 
Cluster display 
These settings are global and therefore are the same for each scenario. 
Show path 
If this option has been checked, the expected path, which is a specific angle 
of decline or rise as well as the bandwidth that will contain price 
movements, will be shown in the chart. If not checked, still the Target zones 
could be shown. 
Show Fibonacci Target Zones 
Use this option to toggle the display of Target zones. 
Update automatically 
If this option has been checked, the TARGET ZONES and / or PATH will be 
recalculated whenever changes occur to the (display) of the chart. You will 
need a very fast computer for smooth operation. Normally, on slower 
computers, the preferred setting will be off. Press F12 or the TZ button in 
the right hand corner of the chart window to refresh the PATH and TARGET 
ZONES. 
Detail 
This option is also included to toggle settings for slower computers. The 
lower the resolution has been set the quicker the calculation and display will 
be completed. 
Change color 
Use this option to change the color of the PATH and TARGET ZONES to 
your own preferences. 
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Introduction to Manual Wave Count 
Attention: Some of the tools will only work with a manual wave count. You 
have to convert an automatic analysis to a wave count first if not using your 
own wave count. 
Using ELWAVE you can label and check your own wave counts very fast. 
First you have to define the wave count of the chart under inspection 
yourself (alternatively you could perform the same operations on an 
automatic analysis, which has been converted to a manual wave count), 
then choose from the main menu Analyze and select Check Wave Count.  
Immediately Wave counts will get checked on specific Elliott rules and 
guidelines and ELWAVE will show the results in an orderly manner, 
displaying the WAVE TREE and WAVE INSPECTOR. 
Make your own wave count 
On top of the screen you will find a window or box called “wave labels”. This 
box can be docked on top of the screen or repositioned anywhere by 
clicking and dragging it to its new position. In the wave label box you will 
find a combo box, which shows the current degree (Supercycle) of the 
visible wave labels. This wave label degree can be changed by clicking on 
the down arrow of the combo box and selecting the wave degree. 
 
(IV) Insert label of higher degree first. 
 
Looking at the chart you have imported, you see for example an obvious 
uptrending “five wave”, which you would like to label accordingly. Go to the 
“wave label” window and grab wave label (IV) 
First drop a wave label (IV) or (II) of higher degree at the low, where the 5-
wave up begins.  
This is needed to mark the beginning of the uptrend of lower degree. 
Now grab wave label I by clicking on this wave label with the left mouse 
button, keep the mouse button pressed down, drag the wave label to the 
right place and drop it by releasing the mouse button. This is the top of the 
first wave or leg, when the chart rises. Notice that ELWAVE automatically 
will search for a high or low to drop the wave label on, which speeds up the 
labeling considerably. Repeat this process for all wave labels you want to 
insert into the chart. Note that you are free to insert these wave labels 
anywhere in any order. Of course, it is important to place these wave labels 
in an orderly fashion to get results that make sense. As soon as you have 
placed label (I) to (V), you could also place the labels of the lower degrees. 
Click on the combo box in the wave label box and select the lower degree. 
Then repeat the drag and drop procedure and so on. We advise you to label 
your chart first, before you go to the next topic, because the objects 
mentioned hereafter depend on these labels to function. A complete 
labeling of one wave degree will suffice. 
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Changing the existing wave labeling 
If you want to change the wave labeling you can grab an already positioned 
wave label and drop it on another bar. In order to grab the label, first point 
at the label and click the left mouse button to select the label. Then click on 
the wave label with the left mouse button and while keeping this mouse 
button pressed down, you drag the label to another position in the chart. 
Release the left mouse button and the label will be dropped on its new 
position. 
 
Changing the color of a wave degree 
Double click a wave label to change the color of all wave labels of the same 
degree. In addition all objects attached to this wave degree will inherit the 
same color. This is a very useful feature to distinct different wave degrees. 
 
Deleting wave labels 
If you want to change the wave labeling you can point at the label and click 
the left mouse button to select the label. Then press the DELETE key or 
choose Edit and Delete from the menu on top of the screen. To delete all 
selected wave labels at once, first select the area, which should be deleted 
using the mouse. The area can be selected by pointing the mouse at the 
beginning of the area, pressing the left mouse button, keeping it pressed, 
dragging the mouse to the end and releasing the mouse button. Next select 
Edit and Delete from the menu on top. Instead of using the menu you can 
also press the DELETE key. 
 
Change wave degree 
Select the wave label or select the section in the chart (by dragging the 
mouse) in which you want to change the wave degree. Next choose Edit 
from the menu on top of the screen and select the menu option Degree up 
or Degree down. 
 
Check manual wave count 
Basically the pattern engine knows how to recognize the patterns by 
checking the rules and guidelines. In addition the engine knows which 
patterns are allowed in sub waves of its parent pattern, because knowing 
which patterns in patterns in patterns… etc. to expect is a very important 
tenet of the Elliott Wave Principle. The program refers to the above by 
“Internal structure”. 
When a computer checks rules to evaluate wave counts, it does so very 
strictly. The outcome is either true or false, there is no in between. 
Consequently, it will reject patterns, even if rules have been violated with 
the slightest margin possible. 
For example the Zigzag pattern, which consists of three waves A B C, does 
not allow the B wave to retrace more than 61.8%. If it retraces 61.9% the 
rule engine will reject the Zigzag. Of course, it is highly arbitrary to set such 
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rules and we recognize the fact that opinions may differ with regard to 
pattern definitions. For this reason we have for example defined a Zigzag 
Flat pattern in our MODERN RULES engine, which allows for a bigger 
retracement than 61.8% for a B Wave. 
Nevertheless, ELWAVE does very well what it is supposed to do. It 
classifies and recognizes the patterns according to its rule definitions, which 
conform to the Elliott Wave Principle. As a result normally only one pattern 
remains if the pattern has been labeled correctly. 
Besides it is possible to load different rule definition files in order to suit 
different preferences. 
The CLASSIC RULES and guidelines set will analyze the wave count 
according to very strict definitions of patterns as required by the Elliott Wave 
Principle and will signal a false internal structure as well.  
Elliotticians who adhere to strict application of the Elliott Wave will find the 
CLASSIC RULES most helpful. Wave counts that fit these rules should 
have a stronger probability anyway. 
The MODERN RULES and guidelines set has a more pragmatic approach, 
taking into account that markets not always conform to text book examples. 
Herein you will find a lot more pattern definitions. You will find for example 
hybrid patterns like “Zigzag Flat”, which is a combination of a Zigzag and a 
Flat. Or falling and rising wedges, more or less similar to ascending and 
descending triangles, are allowed. Another example is that the C wave is 
allowed to get longer than 261.8% of wave A.  
The main purpose for a less strict definition of patterns and allowing for less 
common (hybrid) patterns in the MODERN RULES and guidelines set, is 
the fact that the program will not reject wave counts totally if patterns 
deviate slightly from a text book example. This way you will still get 
presented a possibly valid alternative and decide yourself to reject it or not. 
In addition you could take an extra look at the guidelines to determine the 
probability of the wave count under inspection. The more guidelines have 
been satisfied the stronger the probability of the count. 
How to check hand made Wave Counts 
Tip: Incomplete or unfinished waves are represented by a WAVE BUTTON 
in the WAVE TREE containing a gray cross, if valid patterns have been 
found. At the right of the WAVE BUTTON the first of validated patterns is 
displayed. 
Select Analyze from the main menu and choose Check Wave Count. This 
command can be used to check the wave count of the active chart, to build 
the WAVE TREE and to display specific information on patterns, rules and 
guidelines.  
This is a useful tool to inspect your wave count quickly and in an orderly 
manner. For a description of the use of the WAVE TREE see the section 
below.  
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ELWAVE will analyze your wave count very fast. It will display the patterns 
found next to the wave label in the WAVE TREE.  
Selecting a wave label in the WAVE TREE will display information relevant 
to the pattern found in this wave and display all of the wave degree in the 
price chart. 
In the window named “WAVE INSPECTOR” you will find information on the 
pattern itself as well as the internal wave structure, rules and guidelines that 
have been checked. 
 
Options 
After selecting from the menu Check Wave count, you can choose which 
rules to use for checking a wave count, i.e. MODERN or CLASSIC. 
Additionally you may activate or deactivate (default setting) the option 
CHECK WAVE LABELS. This will check wave labels exactly as they are, so 
if a wave I and II has been inserted this no longer can be an A or B of a 
Zigzag. We advise you to keep the default setting. 
When checking your own wave counts, ELWAVE will always check the 
internal structure of the patterns. If the internal structure is incorrect, it will 
return a message “No patterns match”. 
 
Wave Tree and manual wave counts 
On the left of the screen you will find the so called “WAVE TREE”. You can 
toggle the display of the WAVE TREE by selecting WAVE TREE from View 
in the main menu. 
The WAVE TREE displays the wave degrees in a structured way, 
recognizing the patterns within patterns. Using the WAVE TREE you can 
navigate through the chart and inspect the wave count.  
Clicking the WAVE BUTTONS will zoom in on a specific area in the price 
chart, which is connected to the selected wave degree.  
Together with the information in the WAVE TREE, the patterns, the rules 
and guidelines as well as major mistakes will be shown in an orderly 
manner.  
Notice that the WAVE TREE, the price chart and the messages are all 
interconnected. 
Expand the wave degrees as you like by clicking with the left mouse button 
on the little buttons in the WAVE TREE which show “+” signs. The sign in 
the “+” button will change to “-“. Clicking the same button again will collapse 
the wave degree. 
If you click on a “+” or “-“ button or a button which contains a wave label, the 
appropriate section of the chart will be shown at the same time together 
with the correct wave detail level. 
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Each large WAVE BUTTON represents a wave and contains the connected 
wave label of this wave. Next to the WAVE BUTTON you will find the 
pattern that ELWAVE has found.  
If no valid pattern could be found, the WAVE BUTTON contains a red cross 
and the message “No patterns match” will appear, indicating that the wave 
has been labeled incorrectly (apart from the upper wave degree).  
The message “undefined” will appear if the relating wave has not been 
labeled. This is not considered to be an error. 
Double click the WAVE BUTTONs in the WAVE TREE to display more 
information about this wave. This will make the WAVE INSPECTOR appear 
as described below. 
Underneath the WAVE TREE you will find a separate window, which lists 
the main errors found in the wave count. These errors are: 

• No patterns match 
Probably the wave labeling is incorrect, because no matching pattern 
could be found. Also a wave label could be missing. 

• Missing wave degree 
A wave degree is missing in the order in which the waves have been 
labeled. For example the parent wave is of Primary degree, while its 
sub wave is of Minor degree instead of Intermediate degree. 

Clicking on these errors will navigate you directly to the right spot in the 
chart and in the WAVE TREE, facilitating correction of mistakes fast and 
easily. 
Once you have corrected an error, just check the wave count again to 
inspect whether violations still exist. 
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Wave Inspector and Manual Wave Counts 
The WAVE INSPECTOR will show up when you have instructed the 
software to check the wave count or as soon as an automatic count has 
been completed. You can close it by clicking on the X button at the right top 
of the window and reopen it by double clicking a WAVE BUTTON in the 
WAVE TREE 
The WAVE INSPECTOR displays information on the wave, which has been 
selected in the WAVE TREE. 
On top in the left list box you will find the matching patterns, at the right you 
will find dismissed patterns. 
You can select matching or dismissed patterns by clicking on them with the 
left mouse button. Immediately the WAVE INSPECTOR will show 
information on the selected pattern. 
First a brief definition of the selected pattern is given, followed by Internal 
structure, Rules and Guidelines. In front of the rule or guideline you will 
notice a special character, if it has been violated or correct. 
Rules and Guidelines with a question mark? have not been checked by the 
program and are referred to as “undetermined”. 
A pattern, which has appeared in the left list box, will show correct rules 
only. The guidelines could be violated, but logically these do not reject the 
pattern, it can only reduce its probability. 
The CLASSIC pattern definition requires a wave count, which adheres to 
strict Elliott Wave rules and patterns. 
 
Pattern in chart 
Along with the information in the WAVE INSPECTOR, by default the 
selected pattern will be displayed in the chart, along with the SWING 
FILTER and TARGET BAR. With respect to finished waves (waves already 
completely defined) you can easily project each pattern in the chart to 
inspect which pattern has the best fit by selecting the listed pattern in the list 
boxes on top of the WAVE INSPECTOR. ELWAVE will intelligently 
calculate and draw the patterns by using the begin and end points of the 
wave. 
Looking at unfinished or incomplete waves it is even more interesting to 
project still possible alternatives, based on the wave count defined by the 
user. Validated patterns will use the already defined waves, to draw the 
pattern in the chart.  
If, for example wave 1 and wave 2 have been labeled, these waves will be 
used to calculate an Impulse pattern, while wave 3,4 and 5 will be 
calculated using the price and time relationships of wave 1 and 2. 
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In addition, dismissed patterns can be visualized in the chart giving 
important information on all possible alternatives and enabling you to 
compare the fit of the pattern with the actual chart. 
If for example you have labeled an unfinished wave as wave 1 and 2, this 
could still be a wave A,B in a Zigzag or even a Double Zigzag, depending 
on the parent wave. The pattern shown in the chart will clearly guide you, 
which alternatives are worth wile to investigate. 
Notice that with regard to unfinished waves the WAVE TREE will eliminate 
those patterns of which the rules already have been violated.  
For example as soon as prices exceed the end of wave 3, a truncated 5th 
will no longer be possible and eliminated. 
Options 
Several preferences with regard to the WAVE INSPECTOR and the 
analysis can be defined by the user. 
Select from the main menu Options and choose the menu item WAVE 
INSPECTOR to decide what information gets displayed in the WAVE 
INSPECTOR. Please note that display of TARGET BARS and SWING 
FILTER is connected to display of PATTERN IN CHART Below we show 
the dialog box that will appear. 
 
Trouble shooting 
To correct your wave count, if any errors have been reported by the 
software, use the WAVE INSPECTOR and check the following: 
The message “no pattern found” could indicate that: 

• The wave has not been labeled completely. A common error is f.i. 
that wave 5 is not inserted 

• The wave has not been labeled correctly, wave degrees have been 
mixed or defined twice 

• The pattern is incorrect because rules have been violated, which can 
be checked using the WAVE INSPECTOR. Some examples: Wave 2 
retraces too much, wave 3 is the shortest wave and so on. 

A sub wave of a bigger wave should be of ONE lower wave degree, if not, 
this will generate the message “missing wave degree”. 
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Technical Tools 
In this section you will learn the essentials in more detail in order to start 
using the program as a tool right away.  
We have assumed that you are familiar with the Windows environment, the 
way the menu works and so on. If not, you will have to study your Windows 
manuals. You will also need to know how to drag and drop objects, which 
we have explained in the beginning of the manual under the subtitle 
Interface. 
Tip: You can change the properties of all objects in the price chart and the 
indicator pane by clicking with your left mouse button on these objects. 
Alternatively you can double click with the left mouse button to change its 
properties. Notice that the mouse pointer will change when moving over an 
object. 
 
Scrolling the chart 
This function will allow you to easily find that section of the chart that is of 
special interest to you. To scroll the chart press the scroll bar positioned at 
the lower left corner of the chart window. To scroll left press the left arrow or 
left of the scroll button and vice versa to scroll right. If you scroll the chart 
far enough to the right, empty space will appear where the price data stops. 
 
Charting styles 
To change the charting style, choose from the menu on top of the screen 
the option View, next select the menu item Charting styles… 
 
If you select this menu item a dialog box will appear, where you can select 
one of the following styles: 
 

• OHLC Bar 
This chart displays the price chart as bars, including open and 
closing prices. Using this chart you will see three times less detail in 
your price chart 

• HL Bar 
This charts displays the price chart as bars without Open and Close. 
Using this chart you can display the maximum number of price data 

• Line 
this chart displays a line graph by connecting the closing prices  

• Candlestick 
The price chart will be displayed as a so called Candlestick chart 

• Elliott OHLC Line 
This charting style has been specially designed for the Elliott Wave. 
Each time interval in the price chart will display the Open, High, Low 



 

 

109

and Close in the order they occurred, provided this information is 
available which is not the case in normal End-of-Day charts. 

• Elliott HL Line 
This charting style has been specially designed for the Elliott Wave. 
Each time interval in the price chart will display the High and Low in 
the order they occurred. Alternatively you can position the mouse 
pointer above empty space of the price chart and double click the left 
mouse button. A dialog box will appear in which you can change the 
charting style by selecting the charting style of your choice from the 
drop down box. We will explain the dialog box below: 

• Graph type 
As explained above under charting styles 

• Component 
Select if you would like to change the setting of for example the High-
Low bar, the Open and so on. You can change pixel size or color 
settings 

• Color 
Change the color of the Bar, line, Candlestick etc. 

• Size 
Change the size (in pixels) of a Bar, Line, Candle stick etc. 

 
Zoom 
NOTE: the steps you have made while zooming in, will be remembered by 
the program. 
NOTE: the zoom selection will only apply to the time period (X-axis) not the 
price scaling (Y-axis), which will scale automatically! 
The zooming function allows you to take a detailed look at a specific section 
of the chart. First click the right mouse button and select Zoom in from the 
menu. Alternatively you can select Zoom in from the View menu. The cursor 
will change to a magnifying glass. Click the mouse at the beginning of your 
selection and drag the mouse to the end of your selection to select the area 
you would like to see in detail. Release the mouse and you will now see in 
detail the selection you have made. By choosing the menu item Zoom out, 
you will return to your previous chart view. The Zoom Reset option will reset 
all the zooming steps you made, and show the entire chart plus empty 
space to the right. 
 
Scaling 
The scaling of the Price (Y-axis) will be done automatically by the program 
in such a way that the high and low of the chart will always be visible. 
The Y-axis can be adjusted by clicking the left margin. In the margin you 
see two kind of buttons, which can be dragged or clicked. If you click the 
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button on top, you can adjust the margin at the top of the chart. By clicking 
the button at the bottom you can adjust the margin below the low of the 
chart data.  
For example increase the available space above the high of the chart, to 
reveal all wave labels, by dragging the border of the button down or click 
just under the button in the margin. Clicking just under the button will 
increase the area above the high. 
To increase the margin under the low of the chart, for example to reveal all 
wave labels, drag the border of the button up or click just above the button 
in the margin. Clicking above the button will decrease the area under the 
low. 
 
Compression 
For example using this option, you can compress the time period from daily 
to weekly to fit a longer time period in your chart view. Normally you won’t 
need this option because ELWAVE will compress automatically, if automatic 
compression is on. This is very convenient; the only drawback is that gaps 
like those in daily graphs don’t appear.  
To compress time periods (X-axis), press the right mouse button and select 
Compression from the menu. Then select the compression of your choice. 
Resetting the compression will still show the last price data of the chart. The 
software will make calculations to fit as many data points in the chart 
window as possible. 
Detail level 
Detail level is linked to wave degrees. You can determine up to which wave 
degree you would like to see the wave labels and attached objects. Click 
the scroll bar at the right underneath the chart to adjust detail. 
 
Rescaling of panes 
The size of the panes for indicators, Fibonacci and volume can be changed 
by grabbing the borderline between the pane and the price chart and 
dragging it to a new position. 
Trend lines 
Conventional technical analysts connect lows or highs when drawing trend 
lines, while Elliotticians connect the points where waves begin or end, which 
could make an important difference. In ELWAVE both methodologies are 
supported.  
A trend line can be inserted anywhere in the price chart, even in the 
indicator window, which we will explain later. In this program a trend line is 
an object, like all the objects in the “objects” window or box. 
To place a trend line grab (like always; click on the trend line with the left 
mouse button, while keeping the mouse button pressed) the single trend 
line from the CHART OBJECTS box, drag the trend line to the place where 
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it should be inserted and drop it (by releasing the mouse button). Then click 
precisely on the trend line, this way it is selected and you can adjust it. After 
selecting the trend line two handles will appear (small square boxes). To 
resize or move the trend line, grab a handle and drag it to the right position. 
If you drag it on a wave marker the trend line will attach itself to this wave 
marker. This means it will be repositioned when you grab and drag the 
wave label later on. Repeat this for the second handle of the trend line. 
To change the properties of the trend line, position your mouse pointer 
exactly on the trend line, press the right mouse button and choose 
properties.  
Alternatively you can more easily change the properties of any object by 
double clicking it with your left mouse button. 
Special feature 
Watch what happens when you drop the trend line on a wave label! It will 
automatically connect with the previous wave label. For example dropping 
the trend line on wave 4 will connect a line from wave 2 to wave 4 (with an 
automatic extension). Dropping it on wave B will connect the line with the 
previous wave 5. 
Practice this option now by dropping trend lines on any labels. 
 
Channels 
Channeling is an important technique used by Elliott Wave analysts in order 
to get realistic price targets, therefore this is thoroughly supported in this 
program. Channels can be inserted manually or the software will insert 
them automatically after automatic analysis of the chart. The latter channels 
cannot be selected.  
The following describes how to insert channels manually in the chart. Like 
trend lines, a channel is an object. Channels can be dropped anywhere in 
the chart. Then select the channel by clicking on it and adjust its position by 
grabbing the handles.  
A more convenient way to use channels is to label the chart first and then 
grab the channel icon from the objects box, drag it to the wave label which 
you would like to channel and drop it on this wave label. Notice that 
dropping the channel on wave label (II) will connect this wave label with the 
origin of wave (I) and draw a parallel line from wave (I). Dropping the 
channel object on wave label (III) will connect waves (I) and (III) and draw a 
parallel line from wave (II). Logically dropping it on wave (IV) will connect 
waves (II) and (IV) and draw a parallel from wave (III). This also works in 
corrective waves, where you can drop the channel on wave label (B). Don’t 
hesitate to try this now! Of course, you are not obliged to drop the channel 
on a wave label. You can drop a channel anywhere you like. To resize or 
reposition the channel click on one of the trend lines of the channel and 
three handles will appear. The handles work in the same way as those of 
the trend lines mentioned in the above section. The only difference is that 
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the parallel will move together with the base line. The handle on the parallel 
line can be used for repositioning the parallel line. Naturally this line will 
always keep its parallel position. 
To change the properties of the Channel position your mouse pointer 
exactly on the Channel, press the right mouse button and choose 
properties.  
Alternatively you can more easily change the properties of any object by 
double clicking it with your left mouse button. 
 
Speedlines 
Grab from the chart object toolbar the speedlines button and drop it in the 
chart or on a manual wave label. Click on the upper speedline to adjust the 
drawing of the speedlines, handles will appear which can be used to 
readjust the speedlines.  
With respect to uptrends, connect the beginning of the speedline or the first 
handle to the low and the second handle to the first important high. 
The market should find support at the 2/3 speed resistance line. If this 
breaks, most probably the lower degree pattern has been completed and a 
wave of higher degree is in progress. 
If the market breaks below the 1/3 line it gets more likely that a new low is 
just around the corner. 
Theoretically all speedlines should provide important support and 
resistance. 
 

Projecting Targets 
Tip: you can adjust the way targets are displayed by choosing the menu 
item Targets from the menu option View. You can choose to display target 
ratios and /or values. In addition you can choose to display targets at the 
right or at the left of the target line 
Using ELWAVE you can project targets yourself once you have determined 
the wave count by manually labeling the chart first. These targets are based 
on Fibonacci relationships, which play an important role in Elliott Wave 
analysis. So with the help of the Targets tool you can make strong 
probability forecasts provided you have made the correct wave analysis. 
The following method of projecting targets only works on charts with manual 
wave counts. Once a chart has been analysed automatically, choose from 
Analysis the option Convert to wave count to generate a manual wave 
count quickly. 
To project targets first select a wave label on which the target should be 
based. Next press the right mouse button and choose from the menu Quick 
targets.  
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If, for example, wave 1 and 2 are finished, and you would like to project 
several targets for wave 3, select wave label 2, click the right mouse button 
and choose Quick targets from the menu. Instantly the targets will be 
projected in the chart along with the Fibonacci ratio on which it has been 
based. 
When you project targets based on waves mentioned underneath, the 
following calculations will be made: 

• wave 1: retracements of wave 1 of 38.2%, 50%, 61.8% and 76.4%  

• wave 2 : the price length of wave 1, times a Fibonacci ratio of 61.8%, 
76.5%, 100%, 161.8% and 2.618% will be added to the end of wave 
2, which is the beginning of wave 3, 

• wave 3 : retracements of wave 3 of 23.6%, 382%, 50% and 61.8% 
are calculated, 

Tip: change the wave count while your Targets are displayed. Grab the 
wave label to which targets are attached and drag it to its new place. Note 
that the targets of this wave label (and related wave labels) will change 
instantly when you reposition the label. If the new targets fit the price action 
better after moving the wave label, you could have found an interesting 
wave label position. 

• wave 4 : the price length of wave 3, times a Fibonacci ratio of 61.8%, 
100%, 161.8% and 2.618% will be added to the end of wave 4, which 
is the beginning of wave 5, 

• wave 5 : retracements of wave 5 of 38.2%, 50% and 61.8% are 
calculated, 

• wave A : retracements of wave A of 38.2%, 50%, and 61.8% are 
calculated, 

• wave B : the price length of wave A, times a Fibonacci ratio of 
61.8%, 100%, 161.8% and 2.618% will be added to the end of wave 
B, which is the beginning of wave C, 

• wave C : retracements of wave C of 38.2%, 50%, 61.8% and 76.4% 
are calculated, 

• wave X : the price length of the previous wave C, times a Fibonacci 
ratio of 61.8%, 100%, 161.8% and 2.618% will be added to the end 
of wave X, which is the start of the next pattern, 

• wave D : the price length of the previous wave C, times a Fibonacci 
ratio of 61.8%, 100%, 161.8% and 2.618% will be added to the end 
of wave D, which is the start of wave E, 

• wave E : the price length of the previous wave D, times a Fibonacci 
ratio of 61.8%, 100%, 161.8% and 2.618% will be added to the end 
of wave E. 
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Changing Target Properties 
Position your mouse pointer on the target line and press the right mouse 
button. A menu will appear from which you can choose Properties... and a 
dialog box will appear. Here you can change the appearance of the targets. 
Alternatively you can double click a target line to change its properties. 
Deleting Targets 
To delete targets click on the target line. The selected target line will be 
highlighted. To select multiple target lines at the same time, keep the 
control key pressed and click on the next target and so on. Then press the 
DELETE key or choose Delete from the View menu. 
 

Spirals 
Logarithmic Spirals can be placed anywhere in the chart with "drag and 
drop". You can find the Chart object box on top in which you will find the 
Spiral button. Move the mouse pointer to the window, click the left mouse 
button on the spiral in the CHART OBJECT box, keep the mouse button 
pressed, and drag the spiral to its correct position. Release the mouse 
button and the spiral will position itself on the spot you have indicated. 
Notice that spirals can be attached to wave labels as well. 
These spirals use the golden ratio of 1.618 and turn left. Spirals not only 
show a price target, but also a time target. However, it is of paramount 
importance to adjust the scaling of Y- and X-axis correctly, which needs a 
lot of experimenting. 
To change the properties of the Spiral, position your mouse pointer exactly 
on the Spiral, press the right mouse button and choose properties.  
Alternatively you can more easily change the properties of any object by 
double clicking it with your left mouse button. 
 

Trigger Lines 
Trigger lines can be placed anywhere in the chart with "drag and drop". You 
can find the Chart object box on top in which you will find the Trigger line 
button. Move the mouse pointer to the window, click the left mouse button 
on the Trigger line in the Chart object box, keep the mouse button pressed, 
and drag the Trigger line to its correct position. Release the mouse button 
and the Trigger line will position itself on the spot you have indicated. Notice 
that Trigger lines can be attached to wave labels as well. 
If a real-time feed has been activated, in the Intra day version running under 
Windows 95 or NT, Trigger lines will generate a sound the moment the 
price action penetrates the trigger line up or down. Copy a sound file with 
the extension “.WAV” file to the root of drive c:\ before you start the program 
to enable this. These Trigger lines can be inserted at specific places in the 
pattern to generate warnings of possible Buy or Sell signals. 
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To change the properties of the Trigger line, position your mouse pointer 
exactly on the Trigger line, press the right mouse button and choose 
properties.  
Alternatively you can more easily change the properties of any object by 
double clicking it with your left mouse button. 
 

Golden Ratio Time Ruler 
Tip: Dragging one of the controls of the TIME RULER and pressing SHIFT 
when releasing it near a top or low, will force the TIME RULER to connect 
exactly to that high or low! 
The TIME RULER can be placed anywhere in the chart with "drag and 
drop". You can find the CHART OBJECT box on top in which you will find 
the TIME RULER button. Move the mouse pointer to the window, click the 
left mouse button on the TIME RULER in the Chart object box, keep the 
mouse button pressed down, and drag the TIME RULER to its correct 
position. Release the mouse button and the TIME RULER will position itself 
on the spot you have indicated. Notice that TIME RULERs can be attached 
to wave labels as well. 
If you click on the horizontal line of this time object exactly, you will select 
the object. Two controls will appear, which you can grab and drag to 
reposition the object as well as to drop it on a wave label. If the object is 
selected press DELETE to erase the object.  
The TIME RULER object displays the Golden ratio and facilitates finding 
such time relationships. 
You could for example use the time object to find a date for a new future 
low by connecting lows. The same goes for major highs, but of course then 
you have to connect major highs or try to find clusters by connecting all 
major reversals. 
If you put the origin of the line at the first major low and the1.00 point at the 
second low, you will have a forecast for the following major low at point 1.62 
(which is 38.2% of the length of the beginning of the line to point 1.00) and 
at point 2.62 (which is 61.8% of the before mentioned length). If you 
experiment with this tool, you may find interesting Fibonacci time clusters 
that forecast future price action. 
To change the properties of the TIME RULER, position your mouse pointer 
exactly on the TIME RULER, press the right mouse button and choose 
properties.  
Alternatively you can more easily change the properties of any object by 
double clicking it with your left mouse button. 
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Fibonacci Ratios 
Fibonacci relationships play an important role in Elliott Wave analysis. 
Fibonacci ratios, price ratios as well as time ratios, can help you to discover 
the underlying wave count. The more Fibonacci ratios you find in your wave 
count the better your wave count is. With the correct wave count at hand 
you can make strong probability forecasts for the markets.  
In this version only Fibonacci price relationships are implemented. 
Tip: change the wave count while your Fibonacci pane is open. Grab the 
wave label you would like to reposition and drag it to its new place. Notice 
that the Fibonacci ratio of this wave label (and related wave labels) will 
change instantly when you reposition the label. When the thermometer 
turns red you might have found an interesting wave label position, provided 
you don’t break the rules. 
To display Fibonacci price relations, you have to label your chart first or 
convert an automatic labeling to a manual wave count. Next select one of 
the wave labels of the main wave degree you would like to analyze. It 
doesn’t matter which wave label of that degree you select. Choose Insert 
from the main menu and select Fibonacci Pane. Above your price chart, the 
Fibonacci Ratio pane will appear. Use the scroll bar on top at the left if no 
columns are visible.  
Notice that the ratios of the wave degree you have selected will appear in 
the first column at the left. The next columns display all underlying waves of 
one lower wave degree of the selected wave, starting with wave 1 or A.  
Left of the Fibonacci ratio you will find the waves on which the relationship 
is based. For example “2 : 1” means the relationship between the price 
length of wave 2 compared to the length of wave 1. 
Underneath each relationship you will find a thermometer. The more perfect 
the Fibonacci ratio is, the more expanded and the more red the 
thermometer will be. 
If you spot perfect Fibonacci relationships, you will know you have made a 
fine wave count. If only a few Fibonacci ratios show up, you could change 
your wave count and repeat your Fibonacci analysis until you like the 
results. 
In this way you can see all Fibonacci relationships of a wave at a glance. 
Deleting the Fibonacci Pane 
To remove the entire Fibonacci pane you can grab the lower border of the 
pane and drag it to the top. Release the mouse button and the pane will 
disappear. 

Scenarios 
NOTE: In a scenario file everything you have defined will be saved. This 
includes wave labels, trend lines, channels, targets, zooming, indicator 
panes, positioning of the price chart window and so on. 
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Now it is possible to save the automatic analysis that contains all alternative 
wave counts that are still validated, provided the Automatic analysis module 
has been included with your purchase. 
Scenarios are an important feature, because by comparing your hand made 
scenarios you can keep track of the possible alternatives, their likelihood 
and get a more clear picture in order to forecast price movements. 
To save a scenario is very easy. Each scenario is saved in a different file. 
Once you think it is worthwhile to save the work you have done or an 
automatic analysis, choose Scenario from the main menu, then select the 
menu item Save or Save As. Fill in the name of the scenario and click OK. 
This way you can save as many scenarios as you like. Suppose you edit 
your first scenario now to make an alternative scenario, do so and then 
save it under a different name by using the menu option Save As. 
 
Simulation 
A very educational feature is the powerful simulation feature. Choose 
Truncate Price data to enable simulations of the chart under inspection. You 
can instruct ELWAVE to disregard price data in order to study the outcome 
that ELWAVE would present without knowing these data. This way you can 
really learn how the Elliott Wave works and determine your most preferred 
trading or investment strategy.  
Truncate the price data whenever you like to investigate what the analysis 
looks like as if future data were unknown to ELWAVE.  
Before you choose this option, move the mouse pointer over the chart area 
where you would like to truncate the chart and watch the right end part of 
the status bar for the index number, which has to be inserted in the 
Truncate dialog box. Next have ELWAVE analyze the chart automatically by 
choosing from Analyze the option Analyze entire chart and use CTRL-1 to 
CTRL-9 keys to add data bit by bit. (Please note that Numlock must be on). 
CTRL-1 will add one data point, CTRL-2 will add 2 data points, CTRL-3 will 
add 4 data points and in the same way a higher number will double the 
number of data points added at once. 
When new data is added the software will check if critical price levels have 
been penetrated. If so, it will update the analysis and refresh information in 
the SUMMARY INSPECTOR as well as show for each time frame in the 
ALERT INSPECTOR which rules of which patterns have been triggered. 

Indicators 
NOTE: All separate windows and panes can be resized by grabbing the 
borderline between the price chart and indicator and dragging it to its new 
position. Also it is possible to close this window by grabbing the borderline 
and dragging it to the very top of this window. 
A selective set of indicators is available, which can help you determine the 
wave structure. Remember that an Elliott Wave trader makes his trading 
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decision mostly on the wave count and not solely on indicator values. On 
the other hand some indicators can be very helpful, because they show 
specific characteristics in different waves.  
Indicators can be added to the price chart or in a separate window. 
Normally, indicators like moving averages and others, which have the same 
scaling as a price chart, are added to the price chart itself. Other indicators, 
like RSI for example, are more clear if displayed in a separate window. 
To add an indicator to the price chart select Insert from the main menu and 
choose the menu item Add New Indicator to Price chart. A list box with 
available indicators appears. Select the indicator you would like to add, click 
on the ADD button and click OK. If you wish you to change the properties 
(number of periods, appearance etc.) of the indicator just click on the 
PROPERTIES button. To remove an indicator click the REMOVE button. 
Tip: Change the properties of an indicator by double clicking the indicator 
line. 
Alternatively you can change the properties of any indicator by double 
clicking exactly on the indicator line with your left mouse button. 
To add an indicator in a new window or pane above the price chart, select 
the menu item Add New Indicator Pane from the Insert menu. The same list 
box will appear and you can select the indicator of your choice. By clicking 
OK the indicator will be displayed. The buttons mentioned above 
(“Properties and Remove”) work in the same way.  
The indicator pane has a special feature. On top of the indicator pane you 
will find “Tabs”, which represent a sheet under which an indicator has been 
put. The first indicator you have defined will appear in the first tab and so 
on. Now it is very easy to switch indicators by just clicking a tab with your 
mouse! 
Probably you would like to save your work, perhaps to create an alternative 
scenario with other wave counts, indicators and analysis.  
The most useful indicators have been included, which are the following, not 
all of them have been explained, since all books on technical analysis 
already clarify their use: 
Tip: Place indicators under TABS in the indicator pane to have fast access. 
If you like to compare indicators, insert each indicator in a different pane. Of 
course this will consume a lot of space and will leave less room for your 
price chart. 

• RSI 

• MACD 

• DMI 

• Momentum 
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• Exponential Moving Average 

• Simple Moving Average 

• Displaced Moving average 

• Rate of Change 

• Elliott Oscillator 

• Stochastic 

• Volume 

• Bollinger Bands 

• Keltner channels 

• Parabolic 

• Time Clusters 
Indicators always have the same compression as the price chart. For 
example if the RSI has been set to a time period of 14 and a daily bar is 
displayed in the price chart, then the RSI will calculate a 14-day RSI. If you 
change the price chart to weekly, the RSI will calculate a 14-week RSI. The 
same accounts for intra day (intra day version only), for example an hourly 
chart creates an 14-hourly RSI and so on. 
Creating an indicator in the price chart 
NOTE: adding indicators to price charts is meant for indicators that use the 
same scaling as the price chart, like moving averages.  
To create a new indicator or to add an indicator in the active price chart 
window, click the right mouse button and select Insert from the menu. Next 
choose New Indicator in Price Chart. A dialog box will appear, which 
displays available indicators at the left and selected indicators at the right.  
At first the box at the right will be empty, so you have to select an indicator. 
After selecting an indicator from the left, you click the ADD button to add 
this indicator to your selection. If you choose to display more then one 
indicator in the same price chart, for example several moving averages, just 
select another indicator and click the ADD button again. Then click OK and 
you will return to the price chart in which the selected indicator(s) will be 
displayed. In theory you can select as many indicators as you like, but too 
many indicators in the price chart will not clarify the picture. 
 
Creating an indicator in a separate pane 
To create a new indicator or to add an indicator in a separate pane, choose 
Insert from the main menu and select the menu item New Indicator Pane. A 
box will appear, which displays available indicators at the left and selected 
indicators at the right.  
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Tip: Alternatively you can double click the indicator line to change its 
properties. 
The box at the right will be empty, you have to select an indicator first. After 
selecting an indicator from the left, you click the ADD button to add this 
indicator to your selection. If you choose to display more then one indicator, 
make a selection again. It is possible to display more moving averages in 
the same window at the same time. Other indicators can not be combined. 
 
Modifying indicators 
If you want to modify an indicator, which has been inserted under a TAB of 
the indicator pane, first click on the tab. Next click the right mouse button, 
while your mouse pointer is positioned on the indicator pane, and the 
indicator dialog box will appear. Select from the right window the indicator 
you would like to modify by clicking on it. Click on the MODIFY button and a 
dialog box will appear in which the appearance and the parameters of the 
indicator can be adjusted. Click on the TAB of your choice, modify the 
indicator and select OK if you agree to the modifications, otherwise select 
CANCEL. 
Deleting or removing indicators 
To remove an entire indicator pane you can grab the lower border of the 
indicator pane and drag it to the top. Release the mouse button and the 
pane will disappear.  
If you want to delete an indicator, which has been inserted under a TAB of 
the indicator pane, first click on the tab. Next click the right mouse button, 
while your mouse pointer is positioned on the appropriate indicator pane, 
and the indicator dialog box will appear. Select the indicator you would like 
to remove from the right window by clicking on it. Click on the REMOVE 
button and the indicator will no longer be selected. 
 
Relative Strength (RSI) 
Relative Strength Index (RSI) is an oscillator developed by J. Welles Wilder, 
JR. It is a very popular indicator and useful when applying the Elliott Wave. 
RSI measures the strength of any price action by monitoring changes in its 
closing prices. It is a leading or a coincident indicator, it never lags the price 
action. The RSI indicator fluctuates between 0 and 100. Horizontal 
reference lines in the RSI are often drawn at 30 and 70. 
 
Trading RSI 
RSI can give several buy or sell signals, which are divergences, patterns, 
trend lines and the absolute level of RSI, the RSI levels as already 
mentioned. Divergences are the most important signals. 
Tip : look for a divergence in the RSI within an impulse wave of any degree, 
which is very helpful to determine a third wave. Normally a third wave 
shows the most extreme reading of the RSI, the fifth wave should fail to 
surpass the low or high of the RSI, set in the third wave of the same degree. 
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Divergences between RSI and prices give the strongest buy and sell 
signals. Normally this happens at tops and lows in an impulsive wave, 
which consists of five waves. If the C wave is equal in length to wave A, the 
RSI should also show a divergence. Generally a divergence indicates that 
the trend is weak and ready to reverse. 
A bullish divergence gives a buy signal, when prices fall to a new low but 
RSI fails to make a new low. You can buy as soon as the first RSI low has 
been below its lower reference line (for example at 30) and the second low 
of the RSI happens above the reference line.  See below. 
A bearish divergence works exactly the same, but the other way round. It 
gives sell signals. You can sell as soon as the first RSI high has been 
above its higher reference line (for example at 70) and the second top of the 
RSI happens underneath the reference line. 
Trend lines, support and resistance lines, and patterns, like “head and 
shoulders”, work fine with RSI. Because RSI leads the price chart, it often 
gives early warnings of likely trend changes. RSI trend lines are penetrated 
before it happens in the price chart and patterns can be completed a few 
days before completion in the price chart. Of course the fifth wave of a RSI 
mostly is a failure, except when the fifth wave is an extension. 
RSI levels indicate that above 70 the market is overbought, which calls for a 
correction, although the RSI can reach 80 and more in a bull market. Under 
30 the market is oversold, so a rise can be expected, but be careful 
because in a bear market a RSI beneath 20 is quite common. So when the 
RSI goes above 70 and certainly above 80, look for a selling opportunity. 
Beneath 30 and certainly 20 look to buy. 
 
Moving Averages 
Tip: Experiment with different time periods for a moving average and try to 
figure out for the waves in a pattern if and by how much the MA line gets 
penetrated by prices when using a specific period. 
For example in a third wave or a C wave- if the time period has been set 
correctly- the moving average line should not be penetrated after it has 
been broken by the price. Wave 4 will break the moving average line, which 
tells you the end of the trend is near. See a 40 EMA example. 
 
A 10-day MA shows the average price for the past 10 days, a 30-day MA 
shows the average price for the past 30 days. A moving average normally 
will be displayed in the price chart as a line, by connecting each day's MA 
values. 
Moving averages can be calculated as a simple moving average, which 
gives each day an equal weight.  
Also, an exponential moving average can be calculated, where the latter 
days are heavier weighted. 
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With a moving average you can see the main trend more easily, because it 
filters out the small price movements. When it rises, the moving average 
shows that investors become more optimistic. When it falls, investors 
become more pessimistic. 
An exponential moving average (EMA) is a better trend-following indicator 
than a simple MA, because it responds faster to the latest price changes 
than a simple MA and skips older data which are less relevant. 
 
Trading Moving Averages 
For the investor moving averages are most helpful in following the trend. 
The direction of its slope in each time frame tells you what the trend of this 
specific time frame is. Be sure to trade in the direction of the trend of the 
time frame you use. When you are trading a trend, you can use a short term 
MA as a stop 
In the price chart you could also display a short term MA and a longer term 
MA. When the shorter term MA crosses the longer MA in upward direction 
this is a buy signal, which confirms the uptrend. When it dips under the 
longer term MA this is regarded as a sell signal. Be careful with this signal, 
because a sideways market shows a lot of crossovers and thus a lot of false 
signals. 
You can also use a moving average as a stop. The shorter your investment 
horizon the shorter your moving average should be. As soon as prices 
break the moving average line you can close your position. This can be very 
useful if you want to invest in a third wave only.  
Moving Average Convergence Divergence (MACD) 
Gerard Appel has constructed a more advanced indicator, called the 
Moving Average Convergence-Divergence, or MACD, which is built of three 
exponential moving averages. It is displayed as two lines, the MACD line 
and a the Signal line. The MACD line is built out of two exponential moving 
averages (EMAs). The signal line is built from the MACD line smoothed with 
another EMA. The MACD line responds more quickly to changes in prices. 
Buy and sell signals occur when the fast MACD line crosses above or below 
the slow Signal line. 
 
Trading the MACD 
You can use the crossovers of the MACD and  

• signal lines to trade with the trend of the market. 

• The fast MACD line crossing above the slow Signal line gives a buy 
signal, 

• The fast MACD line crossing below the slow Signal line gives a sell 
signal 
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Also you can look for divergences as explained with the RSI to determine 
the momentum of the market. Again a wave 3 should have the lowest (bear 
market) or highest (bull market) MACD. Divergences in the MACD don’t 
work on longer term.  
 
Momentum 
The Momentum indicator shows how strong the trend is by measuring its 
acceleration. The faster Momentum gains or loses speed the more the trend 
accelerates. This is a leading indicator, which usually reaches a peak 
before prices reach their highs and reaches a low before prices reach their 
lows.  
Trading Momentum 
The trend is up as long as Momentum gets higher and higher, you can 
normally hold on to your bullish positions. As long as it keeps reaching new 
lows, you can hold on to your short trades. Every time Momentum reaches 
a new high, the uptrend is still accelerating. Every time Momentum reaches 
a new low, the downtrend is still accelerating. 
When the direction of Momentum changes, without having set a divergence 
already, be prepared for a reversal.  
You can use Momentum to catch large trends, for this purpose use a longer 
time frame. If you want to spot changes in the trend quickly, then use a 
shorter period Momentum. 
When the direction of Momentum changes, the pattern could be the third of 
a C wave or the third of a five wave. A small correction will take place to 
form the 4th wave. The fifth wave still has to develop in the same direction 
of the trend. When this fifth wave is underway, you can cover your shorts or 
sell your longs. 
Again a divergence is one of the most powerful signals, which normally 
occurs in every five-wave structure. The bigger the divergence the sharper 
the reversal can be. 
If Momentum fails to make a new high or low, this could be a C wave or a 
five-wave structure, which depends on the wave structure of larger degree. 
If you can recognize five waves in a C wave in a larger trend, which points 
to the opposite direction, and at the same time Momentum makes a lower 
top or a higher low, it is better to close your (trend following) positions at 
once. After a C wave the reversal could be quite sharp. On the other hand, 
if the larger trend is still up, this only could be wave 3 with wave 4 and 5 to 
follow. Here you could hold on to your positions depending on the wave 
degree you have determined. In a larger degree a bigger reversal can be 
expected, making it worthwhile to exit. Later on you could possibly reenter 
at a better price. 
You can also draw trend lines or channels to identify support and resistance 
in indicators. Usually Momentum breaks through its resistance a long time 
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(relatively speaking) before prices do. 
See momentum chart below tops before the top of the market and bottoms 
on the same day. 
Rate of Change 
Rate of Change is quite similar to Momentum, since it also measures the 
strength of a trend. The only difference is that Rate of Change is calculated 
differently. It divides today's price by a past price.The faster Rate of Change 
gains or loses speed the more the trend accelerates. This is a leading 
indicator, which usually reaches a peak before prices reach their highs and 
reaches a low before prices reach their lows. 
Trading Rate of Change (ROC) 
The trend is up as long as Rate of Change gets higher and higher, you can 
normally hold on to your bullish positions. As long as it keeps reaching new 
lows, you can hold on to your short trades positions. Every time Rate of 
Change reaches a new high, the uptrend is still accelerating. Every time 
Rate of Change reaches a new low, the downtrend is still accelerating. 
When the direction of Rate of Change changes, without having set a 
divergence already, then be prepared for a reversal.  
You can use Rate of Change to catch large trends, for this purpose use a 
longer time frame. If you want to spot changes in the trend quickly, then use 
a shorter period for Rate of Change. 
When the direction of Rate of Change changes, the pattern could be the 
third of a C wave or the third of a five wave. A small correction will take 
place to form the 4th wave. The fifth wave still has to develop in the same 
direction of the trend. When this fifth wave is underway, you can cover your 
shorts or sell your longs. 
Again a divergence is one of the most powerful signals, which normally 
occurs in every five-wave structure. The bigger the divergence the sharper 
the reversal can be. 
If Rate of Change fails to make a new high or low, this could be a C wave or 
a five-wave structure, which depends on the wave structure of larger 
degree. 
If you can recognize five waves in a C wave in a larger trend, which points 
to the opposite direction, and at the same time Rate of Change makes a 
lower top or a higher low, it is better to close your (trend following) positions 
at once. After a C wave the reversal could be quite sharp. On the other 
hand, if the larger trend is still up, this only could be wave 3 with wave 4 and 
5 to follow. Here you could hold on to your positions depending on the wave 
degree you have determined. In a larger degree a bigger reversal can be 
expected, making it worthwhile to exit. Later on you could possibly reenter 
at a better price. 
You can also draw trend lines or channels to identify support and resistance 
in indicators. Usually Rate of Change breaks through its resistance a long 
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time (relatively speaking) before prices do. See ROC chart below. Looks 
similar to the momentum chart. 
Elliott Oscillator 
This indicator is very useful in counting waves. It was discovered by Tom 
Joseph in 1987 and named the Elliott Wave Oscillator. Additionally a 
moving average of the Elliott oscillator can be drawn, normally a 5-period 
MA is used, which is the (red) line in the picture at the next page 
The pattern this oscillator produces has a strong correlation with the trend 
patterns of the Elliott Wave. For example the 3rd wave mostly is the 
strongest wave. At this point generally the Elliott Oscillator shows the 
highest value, thus confirming a 3rd wave. 
The Elliott oscillator works in all time frames, provided you have enough 
periods or bars available in your price chart. In order for the Elliott Oscillator 
to produce reliable values your price chart should contain 100 bars 
minimally. 
If you work with intra day data, you can zoom in on each wave to check the 
pattern of the Elliott Oscillator, as long as enough detail is available. 
Formula 
5-period MA - 35 period MA of the (High + Low) / 2 
Trading The Elliott Oscillator 
A divergence between the Oscillator and prices indicates a trend reversal. 
When the market has set new lows but the Oscillator does not, you have 
probably found wave 1 in Elliott terminology.  
When you spot this divergence you could do your first trade and buy the 
market. At this juncture risk is high, so watch the market closely. Always sell 
when the market reaches a new low, since this could be the beginning of a 
renewed sell off. 
Next a correction will take place, which is wave 2. Neither the market will 
reach new lows in wave 2, nor will the Elliott Oscillator. If wave 2 is 
complex, the oscillator will pull back to zero. A simple wave 2 on the 
contrary will hardly affect the oscillator. When the oscillator reaches zero 
you could buy again to profit from the coming 3rd wave, on the condition 
that the pattern of supposedly wave 2 is corrective (when it shows a lot of 
overlap and not a 5 wave) 
Then the market will build wave 3, normally the strongest price movement. 
Both the indicator and the market will reach new extremes. As soon as 
wave 3 has gone beyond wave 1, the market will accelerate sharply. 
The oscillator does not provide for an exit point in this time frame or wave 
degree, so you have to look at the sub wave of this wave degree. If you 
detect a divergence between sub wave 3 and wave 5 of the main 3rd wave, 
you have found your exit. 
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After wave 3 again a correction will take place in wave 4. Notice that wave 4 
will be complex if wave 2 was simple and vice versa. Normally (90% of all 
4th waves) the oscillator will at least retrace to zero in wave 4.  
As long as the oscillator does not retrace more than 138.2% of the wave 
three peak, the correction is considered to be wave 4. If it retraces more 
prepare yourself for a decline, since there is a strong probability that the 
price rise was a corrective three wave in a contra trend price movement. 
When the Oscillator reaches zero you could enter the market again to profit 
from wave 5, on the condition that the pattern of wave 4 was corrective. 
Most of the time the market will make new highs in the 5th wave, but the 
oscillator won’t come near its top in wave 3. This divergence is a strong sell 
signal, on the condition that the pattern of the 5th wave is complete. 
 
If both the oscillator and the market make new highs, you will have to 
relabel the 5th wave to wave 3!  
In addition it could be of importance to monitor the crosspoints of the Elliott 
oscillator and the moving average line a an early warning of a trend 
reversal. 
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Using the Menu  
Scenario 
The Scenario menu is used to import your data for analysis. Furthermore 
you can use the Scenario menu for saving and loading scenario files, which 
contain your manual wave count or you can save an automatic analysis.  
A scenario file will not only remember the wave count, trend lines, channels 
etc., but also the indicators and panes as well as the layout of your scenario 
file. 
In accordance with the Windows standard you can also find the Print menu 
items under the Scenario menu, as pictured below (intra day version for 
Windows 95). 
To access the Scenario menu click on Scenario with your mouse and 
choose the correct menu item. 
Select the Scenario menu and choose New and next From Price data… 
You can use this command to import new data.  
 
Scenario – New 
This command is very important for first time users of ELWAVE. You will 
have to import a MetaStock, ASCII or other data files to start working with 
the program, unless you would like to use one of the example scenarios 
provided. All sorts of different data formats can be imported. 
First select a file type from the drop down box and cruise to the directory 
where your files are located. Select the file in the pane at the right and click 
OPEN. If no file names appear in the list box, you will have to navigate to 
the directory where you keep your files by clicking on the drop down box 
next to LOOK IN, click on the drive or directory to list its contents. Please 
note that only the Intra day version supports intra day files. 
Use the menu option From real-time data feed (intra day version only) to 
collect real-time data from scratch. Wait until the chart appears, which will 
happen as soon as sufficient ticks have been collected. 
Of course an automatic analysis will only be realistic if enough data points 
are available, so you will have to wait for 500 data points or 2 days, before 
choosing automatic analysis. 
After choosing this command and completing the real-time feed dialog box, 
ELWAVE will show a new chart window saying ”waiting for sufficient data to 
display chart” 
DO NOT change, save or do anything before the chart data appears in the 
chart window. 
Load ASCII data 
Select the Scenario menu, choose New and next From Price data… Now a 
dialog box will pop up, choose FILE TYPE ASCII. 
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On choosing this menu, item a dialog box will appear, where you can click 
the file in the section at the right to select which file to load.  
If necessary cruise to the correct directory, that contains your files. Load the 
ASCII file of your choice. Files with extensions like *.prn will be displayed 
automatically, otherwise fill in the correct file name to open your file. After 
pressing the OPEN button a second dialog box will appear. 
Here you can define the format of your ASCII file to load it correctly.  
Specify the correct items and the correct date format for each column by 
clicking on the down arrows in the combo boxes and select the correct 
option.  
If your ASCII file has been defined correctly click OK and the file will get 
loaded. When the file has been loaded, save it as a scenario file by 
selecting Save as. The scenario file has a link to the correct ASCII file, so 
the next time you load the scenario file it will load the ASCII file correctly. 
The data will be imported, so you can start a new scenario from scratch. 
Immediately save this chart as a scenario file, because this scenario file will 
remember where to find the data file. 
Load MetaStock data 
The same applies as above, the only difference is that FILE TYPE must be 
set to MetaStock 3.1 or to MetaStock 6.51. If your data is still 3.1 format, 
then DO NOT specify 6.51. The Downloader used with MetaStock 3.1 data 
may not be able to import the data again. 
Load TC2000 data 
The same applies as above, the only difference is that FILE TYPE must be 
set to TC2000 3.0 or TC 2000 4.0/4.1 
Load CSI data 
The same applies as above, the only difference is that FILE TYPE must be 
set to CSI 
Load FutureSource data 
The same applies as above, the only difference is that FILE TYPE must be 
set to FutureSource. 
Load TechTools data 
The same applies as above, the only difference is that FILE TYPE must be 
set to TechTools. 
Load Keyword data 
The same applies as above, the only difference is that FILE TYPE must be 
set to Keyword. Look for its data in SYS directory, which is a subdirectory of 
the program. 
 
Open Scenaro 
To open an existing scenario choose the Open command from the Scenario 
menu. A dialog box will appear, and you have to specify the file name of the 
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scenario, the directory and the drive. ELWAVE will remember the directory 
which you have used last. If the default directory is not the location of your 
scenario files, then browse to the right directory. Using this menu item you 
can retrieve previously saved “hand made” or automatic analyses. 
The first time you use ELWAVE, you can use the example scenario files or 
import one of your own files, since no scenario files of your own have been 
designed yet.  
File name. 
Type the file name or select the scenario file with your mouse. If you 
double-click on the file name, the chart will load automatically. 
Look in. 
Here you can browse to the directory which contains your files. 
Files of Type 
For now the only file type available is an ELWAVE scenario file. The 
program will add the extension “.elw” to the file name you have specified.  
Open. 
If you have typed the name of the file, confirm to load this file by clicking on 
the OPEN button. 
Cancel 
Click the CANCEL button to leave the OPEN dialog box. No file will be 
loaded. 
 
Close Scenario 
Select the Scenario menu and choose Close. Use this command to close 
the active scenario file. If you didn’t save changes made to the scenario, the 
program will remind you to do so now. Choose YES if you want to save the 
changes using the same name. Choose CANCEL if you change your mind. 
 
Save Scenario 
Select the Scenario menu and choose Save. Choosing the Save command 
will save the scenario file instantaneously. This could be a “hand made” 
wave count or an automatic analysis. This way you can save your scenarios 
fast without renaming them. If a scenario is unnamed, you will be asked to 
provide a file name. If the scenario file already exists you will be asked if 
you want to replace it. Click OK if you agree and CANCEL to return without 
saving. 
 
Save as Scenario 
Select the Scenario menu and choose Save as. The Save as command is 
used to save the current scenario file the first time or to save it using a 
different name. This is useful to create alternative scenarios, which you 
derive from the active scenario. This could be a “hand made” wave count or 
an automatic analysis. In this way it is easy to create as many scenarios as 
you like for the same security. 
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File name. 
Tip: if you change your preferred scenarios often, you could include the 
date in the file name. The preferred scenario for the first of January 1999 
could have the name “dj1999P”. This way you can keep track of the 
chronological changes of your preferred scenarios. 
Type the file or select the scenario file with your mouse. It is helpful to 
specify a file name, which is easily recognizable. For example if you are 
saving the preferred scenario of the Dow Jones, then type “Dowpref” or any 
other file name which reminds you of what it is.  
Save in. 
Here you can browse for the directory where you want to save your files. 
Save as Type. 
For now the only file type available is the ELWAVE scenario file. The 
program will add the extension “.elw” to the file name you have specified.  
Save. 
If you have typed the name of the file, confirm to save this file by clicking on 
the Save button. 
Cancel 
Click the Cancel button to leave the Save dialog. Nothing will be saved. 
Save all Scenario 
Select the Scenario menu and choose Save all. Use this command to save 
all open scenario files at once. If a scenario is unnamed, you will be asked 
to provide a file name. 
 
Export Metastock (3.1) 
elect the Scenario menu and choose Export MetaStock. This command 
exports price data of the active chart to a MetaStock (intra day) file. This 
can be used to convert an ASCII data file to MetaStock format. 
 
Export ASCII 
Select the Scenario menu and choose Export ASCII. This command exports 
price data of the active chart to an ASCII (intra day) file. This can be used to 
convert a MetaStock data file to an ASCII file. 
 
Real-time Data feed 
Select the Scenario menu and choose Real-time data feed. This command 
activates a real-time feed for the active chart and will come up with a dialog 
box, which fields have to be specified. Ask your data vendor for the correct 
codes and format in order to establish the data feed. It is imperative that 
your data vendor supports a so called DDE link. 
Tip: To print the entire screen press the Print screen key, switch to your 
word processor, import the picture with CTRL-V and print it from there. 
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If you can establish DDE links in for example an Excel spreadsheet, you 
can do the same using ELWAVE. 
Print 
Select the Scenario menu and choose Print. The Print command prints the 
active chart, including visible panes as well as THE SUMMARY 
INSPECTOR if you have checked this option in the Print dialog box 
 
Exit 
Select the Scenario menu and choose Exit. To leave ELWAVE choose the 
Exit command. As usual the same can be accomplished by simultaneously 
pressing ALT-F4 on the keyboard. 
 
Recent Scenarios 
Select the Scenario menu and choose one of the recent scenarios. At the 
bottom of the Scenario menu you will find a list of the last scenarios you 
have loaded before. For your convenience ELWAVE will remember the last 
four scenario files. This way you have quick access to the files you probably 
use most. Click on one of the listed files or press the number in front of the 
file. 
 

Edit 
The Edit menu is used to make modifications to your analysis. Some menu 
items allow you to change the wave count easily. Also you can delete 
selected objects with the menu item Delete. This can also be done by 
pressing the DELETE key. Furthermore it is possible to modify the 
properties of the selected object and to copy the chart or screen to the 
clipboard.  
The Edit menu looks as follows: 
To access the Edit menu click on Edit with your mouse and choose the 
appropriate menu item. 
 
Degree Up 
Select the Edit menu and choose Degree Up. This command only works on 
manual wave counts and is specially designed for Elliott Wave analysts. 
Choosing this command will change the wave degree of the selected wave 
label or group of wave labels to a higher wave degree. Note that you first 
have to make a selection by dragging the mouse. 
When analyzing the wave count of a security it often happens that you have 
to change the wave degree up or down, for example when an extension or 
a failure occurs. Instead of deleting the wave label(s) and inserting a wave 
label of higher or lower degree, you can change the wave degree 
immediately. 
 
Degree Down 
Select the Edit menu and choose Degree Down. This command This 



 

 

132

command only works on manual wave counts and is specially designed for 
Elliott Wave analysts. Choosing this command will change the wave degree 
of the selected wave label or group of wave labels to a lower wave degree. 
Note that you first have to make a selection. 
When analyzing the wave count of a security it often happens that you have 
to change the wave degree up or down, for example when an extension or 
a failure occurs. Instead of deleting the wave label(s) and inserting a wave 
label of higher or lower degree, you can change the wave degree 
immediately. 
 
Copy Chart 
Select the Edit menu and choose Copy Chart. Use this command to copy 
the chart to the clipboard. Now you can switch to another Windows 
application like a word processor or a graphical program and paste the 
contents of the clipboard into the application. As opposed to a bitmap 
picture this picture will be relatively small and the embedded objects can be 
edited in another drawing program. 
 
 
Delete 
Select the Edit menu and choose Delete when you want to delete a 
selected object. Note that you will have to select the object first! You can 
also press the DELETE key on your keyboard to delete the object. If you 
want to select a multiple of objects, you can select these objects one by one 
with your mouse, while keeping the CTRL key pressed. By dragging the 
mouse over a certain area of the chart, you can select all objects in this 
area at once. 
 
Properties 
Select the Edit menu and choose Properties... when you want to change the 
properties of a selected object. A dialog box will appear, where you can 
change the appearance and the parameters of the object, if available. 
Alternatively you can change the properties of any object by double clicking 
it with your left mouse button.  
 
The View menu is used to control the layout of your screen. Zooming will 
allow you to display a specific part of the price chart. You can choose to 
show or to delete indicator panes, volume, Fibonacci ratios and the display 
of other objects like for example targets and channels. 
When a price chart gets crowded because you have defined a lot of objects, 
you could choose to show only a selection of objects instead of showing 
them all. 
 
Zoom In 
Select the View menu and choose Zoom In. First you have to select this 
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command and then select the area of the price chart by dragging your 
mouse. Then you can use this command to zoom in on the selected section 
of the price chart.  
ELWAVE will remember all your zoom in steps and save them in a scenario 
file. With the Zoom in and Zoom out function you can show more or less 
detail in the price chart. 
 
Zoom Out 
Select the View menu and choose Zoom Out. You can use this command to 
zoom out and go back one step at the time, repeating the same steps you 
did when zooming in. ELWAVE will remember all your zoom in steps. 
 
Zoom Reset 
Select the View menu and choose Zoom Reset. This command can be 
used to reset all zooming steps you have made while using ELWAVE. Once 
you have reset zooming the zoom steps will be lost! Don’t save the scenario 
file if you would like to retain these steps 
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.Hairline 
Select the View menu and choose Hairline. This command will allow you to 
toggle the display of the hairline. 
 
Semi-Log 
To change the scaling of the chart (Y-axis), choose from the menu on top of 
the screen the option View, next select the menu item Semi-log.  
If semi-log is the current scaling, you will notice a marker in front of this 
menu item. To change the scaling to line chart, choose the menu item 
Semi-log (now the marker in front of it will disappear). Alternatively you can 
change the properties of the price chart by double clicking the right mouse 
button on any region of the price chart as long as it is not occupied with any 
object. In a semi-log scaled chart, the distance between each point is 
exponential, which means that the distance between 20 and 40 (a 20 point, 
100% increase) is the same as the distance between 40 and 80 (a 40 point, 
but still 100% increase). 
 
Targets 
To toggle the display of target ratios, which are printed, left of target lines, 
choose Target Ratios. This option is useful when the ratios, printed at the 
left of the target lines, diminish the clarity of the chart. You can choose to 
display target ratios and/or target values at the right or the left of the target 
lines or to display just the target lines. 
 
Charting Styles 
To change the charting style, choose from the menu on top of the screen 
the option View, next select the menu item Charting styles… If you select 
this menu item a dialog box will appear, where you can select the charting 
styles: 
 
The picture below shows the dialog box to choose from the different 
charting styles. 
Alternatively you can position the mouse pointer on empty space of the 
price chart and double click the left mouse button. A dialog box will appear 
in which you can change the charting style by clicking the drop down box. 
 

Wave Tree 
Select the View menu and choose WAVE TREE. This command will allow 
you to toggle the display of the WAVE TREE. 
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Wave Inspector 
Select the View menu and choose WAVE INSPECTOR. This command will 
allow you to toggle the display of the WAVE INSPECTOR. 
 
Summary Inspector 
Select the View menu and choose SUMMARY INSPECTOR to display the 
summary of trading signals for all time frames. 
 
Alert Inspector 
Select the View menu and choose ALERT INSPECTOR to display the latest 
activated signals for all time frames. 
 
Panes 
Select the View menu and choose Panes. This command will allow you to 
select which indicator panes will be displayed in the active chart. Also, you 
can remove the panes from the screen or redisplay them later on. The size 
of the pane can be adjusted by grabbing the separation border of the pane 
and dragging it to its new size. 
If you select this menu option you will find a list of panes, which are 
available for the active window. The panes are listed in the order they 
appear in the active chart window. By selecting or deselecting the particular 
pane you can toggle its display. 
The size of the pane can be adjusted by grabbing the separation border of 
the pane and dragging it to its new size. 
 
NOTE : to display or remove volume you can select the View menu, choose 
pane and select or deselect Volume. 
 
The Insert menu can be used to add several things you would like to have 
displayed in your chart, like for example new indicators and Fibonacci 
ratios. Indicators can be added either in a new pane or in the price chart. 
For some indicators only, it is useful to display them in the price chart, as for 
example moving averages. Because a lot of objects will be added in the 
price chart already, it is recommended to add most of the indicators in a 
separate pane. In each pane you can insert several indicators under the 
tabs on top of the indicator pane. 
New Indicator Pane 
Select the Insert menu and choose the menu item New Indicator Pane.This 
command will insert the indicator of your choice in a new pane above the 
price chart. Theoretically you can add as many indicator panes as you like. 
On top of each pane you will notice several tabs, which are empty at first. 
Each time you click on one of these tabs another view will be displayed. 
This view can contain just one or several indicators. 
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Tip: if you like, you can add more then one indicator in the same pane. You 
could add a different indicator under each tab. By just clicking with your 
mouse on the tab of your choice, you can instantly access the indicator you 
would like to display. 
If you choose this command a dialog box will appear with the available 
indicators on the left side and the selected indicators at the right. Here you 
can add and remove indicators, as well as change properties.  
You can use the ADD(>>) button to add indicators to the price chart or to 
the indicator pane. At first no indicators will be selected, so you have to 
select the desired indicator from the left list box by clicking on it with the left 
mouse button. Then click the ADD button and the indicator will appear in 
the list box. Now click the OK button to return to the chart, where the 
indicator will be displayed. If you change your mind and want to remove the 
indicator, then click on the REMOVE button before pressing OK.  
To change the properties of the indicator, like for example the color and 
indicator specific variables, press the PROPERTIES button. If you don’t 
want to add new indicators at all, press the CANCEL button and you will 
return to the price chart without modifications. This only works when you 
have not yet selected an indicator. 
To add an indicator in an empty TAB of an indicator pane, click on the TAB 
and click the right mouse button. An Indicators menu item will appear, 
select it and the same dialog box as displayed above will appear. Now you 
can add another indicator in the same pane. By clicking on the TABS you 
can switch indicators quickly. 
Remove indicator 
To remove an indicator select the REMOVE button in the indicator dialog 
box. A dialog box will appear with the available indicators on the left side 
and the selected indicators at the right. Select the indicator you would like to 
remove from the list box on the right and press the REMOVE button with 
your mouse. Now this indicator will be removed. Press OK to leave this 
dialog box. 
Properties  
Select the indicator you would like to change from the list box on the right 
and press the PROPERTIES button with your mouse. Another dialog box 
will show up. 
Alternatively you can change the indicator properties by double clicking with 
your left mouse button on the indicator line. 
You can change the specifications of an indicator as indicated by the Tabs 
in the dialog box.  
Parameters 
To change the parameters of an indicator click on the Tab Parameters. Now 
you can change the “time periods” and the data field on which the indicator 
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is based. For example if you prefer a 10-day RSI instead of the standard 
14-day, change the time period from 14 to 10. 
Appearance. 
By clicking on this tab you can change the appearance of the indicator. To 
change the line thickness of the indicator press the drop down arrow at the 
right of “LINE WEIGHT”. Here you can select your preference with the 
mouse . To change the color, press the CHANGE button. In the following 
dialog box you click the color you prefer, which will then appear in the 
COLOR/SOLID box and press the OK button. 
New Indicator in Price Chart 
Select the Insert menu and choose the menu item New Indicator in Price 
Chart. Next select the menu item Price Chart. The same dialog box will then 
appear as already explained in the previous section New Indicator Pane. 
This command will insert the indicator of your choice in the price chart. You 
can add Bollinger Bands, Keltner channels, Moving averages and Parabolic 
indicator. Consult other technical analysis books if you need an explanation 
of these indicators. 
Managing Indicator panes 
If you want to change the indicator panes already in use, position your 
mouse pointer on the particular pane and click the right mouse button. 
A dialog box will show up, which looks the same as when you add a new 
indicator pane to the chart. 
Here you can add and remove indicators as well as change the properties 
of the indicator.  
 
Fibonacci Pane 
This will only work on manual wave counts! Select the Insert menu and 
choose the menu item Fibonacci Pane. This command will insert a pane 
with Fibonacci price relationships. First you will have to select any wave 
label of the wave degree of which you would like to see the Fibonacci ratios. 
The wave degree you have selected will appear in the first column. In the 
following columns the Fibonacci ratios of the next lower degree will be 
listed. Underneath each ratio you will find a temperature indicator, which 
displays how hot the Fibonacci ratio is. The better the ratio, the more red 
and expanded the thermometer will be. 
Volume Pane 
Select the Insert menu and choose the menu item Volume Pane. This 
command will insert the volume in a separate pane underneath the price 
chart of the active chart. 
 
Analyze  
Analyze Entire Chart 
Use Analyze from the main menu if you would like ELWAVE to generate a 
wave count automatically. Select the Analyze menu and choose Analyze 
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entire chart to generate an analysis from scratch, for further explanation see 
the second chapter of this manual. 
Analyze selected wave 
Choose Analyze from the main menu and. Analyze selected wave if you 
would like ELWAVE  to generate a wave count automatically for the 
selected wave in the WAVE TREE to generate an analysis from scratch, for 
further explanation see the second chapter of this manual. 
Update analysis 
Use this option to only reanalyze selectively instead of analyzing the whole 
chart. ELWAVE will know exactly which section of the chart needs to be 
reanalyzed, which will save you precious time. If an undefined wave count 
is returned, you need to reanalyze the chart entirely. Since an Analyze 
entire chart is more precise, it is advised to prefer this analysis. 
 
Check Wave Count 
To check a wave count you have labeled yourself, select the Analyze menu 
and choose Check Wave Count. This command can be used to build the 
WAVE TREE displaying specific information on patterns, rules and 
guidelines all at once. This is a useful tool to inspect your wave count 
quickly and in an orderly manner or to navigate the chart, since the WAVE 
TREE will zoom in on a specific wave degree, thus providing an alternative 
Zoom in function. 
Wave counts will get checked on specific Elliott rules and guidelines, of 
which different sets are available.  
The CLASSIC RULES and guidelines definition will analyze the wave count 
according to very strict definitions of patterns as required by the Elliott Wave 
Principle and will signal a false internal structure as well. 
The MODERN RULES and guidelines definition has a more pragmatic 
approach, taking into account that markets not always conform to text book 
examples.  
The guidelines are helpful to assess the probability of a count. The more 
guidelines have been satisfied, the better the wave count. 
 
Convert to Wave count 
This option enables you to convert your preferred scenario to a wave count 
in order to save it as an scenario file for later use. First select your preferred 
wave analysis on every wave degree possible or accept ELWAVE’s 
outcome. Once you have converted to a wave count you will not be able to 
convert another analysis. 
 
Clear Analysis 
Selecting this option will clear the automatic analysis completely. 
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Start batch processor 
This menu option will start the batch processor program, that enables you to 
analyze multiple charts while you are asleep. Select scenario files to load 
and analyze. 
 
Save Custom layout 
This menu option will save the layout you have made yourself to present 
results. 
 
Custom layout 
This menu option will present your preferred layout which you have 
previously designed and saved. 
 
Custom layout 
This menu option will present your preferred layout which you have 
previously designed and saved. 
 
Simple layout 
This is a predefined layout that skips most of the experts’ information. 
 
Typical layout 
This is a predefined layout that shows a bit more information. 
 
Expert layout 
This is a predefined layout that shows all information an expert could ask 
for. 
 

Options 
Choose Options from the main menu if you like to change the default 
preferences of ELWAVE. 
Analysis Options… 
In order to adjust setup of analysis choose from the main menu Options   
and select Analysis …  
A dialog box will show up where you can change preferences for automatic 
analysis.  
Analysis type 
By default the option FAST will be selected, which usually is the fastest and 
best setting. If you would like to have more detail, choose DETAILED or 
VERY DETAILED.  
Pattern definitions 
Choose the rules engine you would like to use for analysis. The Classic 
adheres to very strict Elliott Wave interpretation, the Modern allows for 
newly found patterns and contains latest research. 



 

 

140

Extra wave degrees 
By inputting 1,2 or 3 extra wave degrees, the software will analyze the last 
unfinished waves in more detail, resulting in extra time frames and more 
detailed information in the SUMMARY INSPECTOR. Of course adding extra 
time frames will increase analysis time. 
Show analyzing 
Start a second session of ELWAVE for collection of real-time data I order to 
watch the markets continuously while another session of ELWAVE updates 
its analysis. 
Switch this on or off, by default ELWAVE shows how it searches for Elliott 
Wave patterns. Switching it off will save a little bit of time. 
Show ALERT INSPECTOR when… 
By default this is switched on. When critical levels are broken because of 
price fluctuations, the software will give appropriate signals automatically 
and if necessary update the previous automatic analysis. 
Automatic Analysis update 
By default this option is switched on, causing ELWAVE to automatically 
start a new analysis if critical levels are broken. You will not be able to 
watch price fluctuations as long as this analysis update needs to complete.  
Limit to once every … 
Depending on the speed of your computer, it will take some time to update 
the analysis. Reanalysing could take from around 20 seconds to perhaps 2 
minutes or even more on slower computers. If you instruct the software to 
update the analysis too often it will get signals before the previous update 
has been completed. 
Minimum bars required… 
In order to make it possible to detect patterns in a wave, this wave should 
have a minimum amount of bars or data points. Increasing the minimum 
number of data points will speed up the analysis, but give less detail. 
 
Analyze selected wave 
Choose Analyze from the main menu and . Analyze selected wave if you 
would like ELWAVE  to generate a wave count automatically for the 
selected wave in the WAVE TREE to generate an analysis from scratch, for 
further explanation see the second chapter of this manual. 
 
Update analysis 
Use this option to only reanalyze selectively instead of analyzing the whole 
chart. ELWAVE will know exactly which section of the chart needs to be 
reanalyzed, which will save you precious time. If an undefined wave count 
is returned, you need to reanalyze the chart entirely. Since an Analyze 
entire chart is more precise, it is advised to prefer this analysis. 
 
Check Wave Count 



 

 

141

To check a wave count you have labeled yourself, select the Analyze menu 
and choose Check Wave Count. This command can be used to build the 
WAVE TREE displaying specific information on patterns, rules and 
guidelines all at once. This is a useful tool to inspect your wave count 
quickly and in an orderly manner or to navigate the chart, since the WAVE 
TREE will zoom in on a specific wave degree, thus providing an alternative 
Zoom in function. 
Wave counts will get checked on specific Elliott rules and guidelines, of 
which different sets are available.  
The CLASSIC RULES and guidelines definition will analyse the wave count 
according to very strict definitions of patterns as required by the Elliott Wave 
Principle and will signal a false internal structure as well. 
The MODERN RULES and guidelines definition has a more pragmatic 
approach, taking into account that markets not always conform to text book 
examples.  
The guidelines are helpful to assess the probability of a count. The more 
guidelines have been satisfied, the better the wave count. 
 
Convert to Wave count 
This option enables you to convert your preferred scenario to a wave count 
in order to save it as an scenario file for later use. First select your preferred 
wave analysis on every wave degree possible or accept ELWAVE’s 
outcome. Once you have converted to a wave count you will not be able to 
convert another analysis. 
 
Clear Analysis 
Selecting this option will clear the automatic analysis completely. 
 
Start batch processor 
This menu option will start the batch processor program that enables you to 
analyze multiple charts while you are asleep. Select scenario files to load 
and analyze. 
 
Save Custom layout 
This menu option will save the layout you have made yourself to present 
results. 
 
Custom layout 
This menu option will present your preferred layout which you have 
previously designed and saved. 
 
Custom layout 
This menu option will present your preferred layout which you have 
previously designed and saved. 
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Simple layout 
This is a predefined layout that skips most of the experts’ information. 
 
Typical layout 
This is a predefined layout that shows a bit more information. 
 
Expert layout 
This is a predefined layout that shows all information an expert could ask 
for. 
 
Options 
In order to adjust setup of analysis choose from the main menu Options   
and select Analysis …  
A dialog box will show up where you can change preferences for automatic 
analysis.  
 
Analysis type 
By default the option FAST will be selected, which usually is the fastest and 
best setting. If you would like to have more detail, choose DETAILED or 
VERY DETAILED.  
Pattern definitions 
Choose the rules engine you would like to use for analysis. The Classic 
adheres to very strict Elliott Wave interpretation, the Modern allows for 
newly found patterns and contains latest research. 
Extra wave degrees 
By inputting 1,2 or 3 extra wave degrees, the software will analyze the last 
unfinished waves in more detail, resulting in extra time frames and more 
detailed information in the SUMMARY INSPECTOR. Of course adding extra 
time frames will increase analysis time. 
Show analyzing 
Start a second session of ELWAVE for collection of real-time data I order to 
watch the markets continuously while another session of ELWAVE updates 
its analysis. 
Switch this on or off, by default ELWAVE shows how it searches for Elliott 
Wave patterns. Switching it off will save a little bit of time. 
Show ALERT INSPECTOR when… 
By default this is switched on. When critical levels are broken because of 
price fluctuations, the software will give appropriate signals automatically 
and if necessary update the previous automatic analysis. 
Automatic Analysis update 
By default this option is switched on, causing ELWAVE to automatically 
start a new analysis if critical levels are broken. You will not be able to 
watch price fluctuations as long as this analysis update needs to complete.  
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Limit to once every … 
Depending on the speed of your computer; it will take some time to update 
the analysis. Reanalyzing could take from around 20 seconds to perhaps 2 
minutes or even more on slower computers. If you instruct the software to 
update the analysis too often it will get signals before the previous update 
has been completed. 
Minimum bars required… 
In order to make it possible to detect patterns in a wave, this wave should 
have a minimum amount of bars or data points. Increasing the minimum 
number of data points will speed up the analysis, but give less detail. 
 
Analyze selected wave 
Choose Analyze from the main menu and . Analyze selected wave if you 
would like ELWAVE  to generate a wave count automatically for the 
selected wave in the WAVE TREE to generate an analysis from scratch, for 
further explanation see the second chapter of this manual. 
 
Update analysis 
Use this option to only reanalyze selectively instead of analyzing the whole 
chart. ELWAVE will know exactly which section of the chart needs to be 
reanalyzed, which will save you precious time. If an undefined wave count 
is returned, you need to reanalyze the chart entirely. Since an Analyze 
entire chart is more precise, it is advised to prefer this analysis. 
Target Zones 
Choose Target Zones… to change settings, which determine what will be 
shown in the chart. See the Target Clusters chapter for more explanation. 
 
Wave Inspector options 
Choose Wave Inspector… to change which information will be shown when 
the WAVE INSPECTOR has been activated. A dialog box will pop up as 
shown below. 
Here you can toggle the listed options to display the information you would 
like to see in the WAVE INSPECTOR window. 
After a while or if you are an experienced Elliott Wave analyst, you probably 
would like to see only the rules and guidelines which have been violated. To 
accomplish this deselect all check boxes and all other information will not 
been shown.  
If you switch show pattern in chart on, not only the PATTERN, but also the 
SWING FILTER and TARGET BARS will be pictured in the chart. 
Snap wave labels to extremes 
By default this switch is on making sure that the wave label you insert in the 
chart is attached to the top or low automatically. If you like to put it at a 
specific spot precisely, disable this setting by selecting this option. 
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Truncate Price Data 
Use this option to start simulations of the chart under inspection. Truncate 
the price data wherever you like to investigate how the analysis looks like if 
future data were unknown to ELWAVE. Move your mouse pointer over the 
chart at the price bar where you would like to truncate the data and read 
from the status bar the index number. Insert the index number in the 
TRUNCATE PRICE DATA dialog box. 
Next have ELWAVE analyze the chart entirely and use CTRL-1 (from the 
numerical keypad, make sure that Numlock is on) to CTRL-9 keys to add 
data bit by bit. If you use CTRL-1 only 1 bar or tick will be added, using 
CTRL-2 will add 2 bars, CTRL-3 adds four bars and so on. The software will 
show you exactly at what cross points it will signal a positive or negative 
indication and when it decides to update the analysis. 
 
Show truncated price data 
If this option is checked, truncated price data will show grayed out in the 
chart. Select this menu item again to hide truncated data. 
Correct Bad Ticks… 
 
Bad ticks will be automatically corrected in intra day charts only, provided 
you have a real time feed enabled. If you load an existing file you could 
have the whole file corrected by selecting this menu option. Make sure the 
settings in the *.ini file of ELWAVE are correct, see the special section on 
real-time data feed. The elwave60.ini file can be found in the Windows 
directory. 
Perform Stock Split 
Using this option you can split an ASCII or Metastock file and save the new 
data. Export of other file types is not supported so these data should be split 
using the data vendors’ software. This option has been added because of 
the conversion of price data to EURO and the huge (intra day) ASCII files 
ELWAVE can handle, which are too large to split in Excel. 
 
Export Summary Signals 
Using this option an ASCII file will be generated in which the activated 
trading signals can be saved for loading and further analysis in Excel. 
 

Screen 
Open screen 
Select the Screen menu and choose Open. This command can be used to 
open previously saved screens. A dialog box will appear in which you can 
specify a screen file by typing its name, or choosing the screen of choice 
from the list box. Then click the Open button to confirm. If the screen is not 
listed, browse to the right directory. 
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Save Screen 
Select the Screen menu and choose Save. Choosing the Save command 
will save the screen instantly. In this way you can save your screens fast 
without renaming them. If you haven’t saved your screen before, a dialog 
box will appear in which you have to specify a screen name by typing it (a 
maximum of 8 characters) or clicking the screen of your choice from the list 
box. If the screen is not listed, browse to the right directory. Make sure you 
give the screen an easily recognizable name. Then click the Save button to 
confirm. 
If the screen already exists you will be asked to replace it. Click OK if you 
agree and CANCEL to return without saving. 
 
Save as 
Select the Screen menu and choose Save as. The Save as command is 
used to save the current screen file for the first time or to save it using a 
different name. This is useful to create different screens, which you could 
build using the active screen. In this way it is easy to create as many 
screens as you like for the same security or multiple securities. 
 
Close Screen 
Select the Screen menu and choose Close. Use this command to close the 
active screen file. If you didn’t save the changes made to the screen, the 
program will ask you if you want to do so now. Choose Yes if you want to 
save the changes using the same name. Choose Cancel if you change your 
mind. 
 
Recent Screens 
Select the Screen menu and choose one of the Recent files. At the bottom 
of the Screen menu you will find a list of the last screens you have loaded. 
For your convenience ELWAVE will remember the last four screen files. 
This way you have quick access to the screens you probably use most. 
Click on one of the listed screens or press the number in front of the file. 

Using the Drawing Tools 
Trendline 
The trendline tool is probably the simplest tool available in ELWAVE, yet it 
is one of the most important.  The reason that it is so important, is that it 
defines the trend that the market is in. There are of course, many degrees 
of market trends – short, intermediate and long term. Whatever degree you 
are in, the trendline can tell you if you are still in it. 
 
The best way to use the trendline is just to draw the straight line on a chart 
connecting low points for an uptrend or high points for a downtrend. You 
must connect at least two points on the chart for it to be valid. These points 
must be reversal points that are indicated to be significant pivot points. See 
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example. 
 
Trendlines can be drawn on three types of trends, uptrends, sideways 
trends and downtrends. A break in the trend is indicated when the trendline 
is broken by either a percentage or number of points. This is because many 
times the trendline is broken only by a small price  or percent amount only 
to recover. A common number used by many is either 3 percent or 3 points. 
The best way to know what is an important number for an individual security 
or commodity is to check back on historical data to see what works the best.  
 
Volume should be watched carefully when a trendline is broken. It can tell 
you if the break is valid or not. A break of a trendline on increasing volume 
means that it is the real thing. A break on light volume is suspicious. See 
the following example and notice the light volume at the top and the 
increase on the break of the trendline. 
Some tips to use with trendlines are: 
 
1) The more bottoms a trendline has the more important it is. 
2) The longer the trendline, the more important it is. 
3) A long trendline with a large number of bottoms hitting the line is more 
important that a long one with just a few bottoms on the trendline. 
4) The steeper the angle of a trendline, the less important it is. The more 
horizontal trendlines are more important. 
5) The fourth wave almost always breaks the trendline, unless it is 
extremely strong. 
The following chart illustrates a minor uptrend first broken by the 4th wave 
and then finally broken by the minor trendline only to go down to the longer 
term trendline. 
Using Parallel Channel Lines 
Channel Lines can be used to define the tops and bottoms of trends. The 
market usually will thrust up to the top of the channel and react back down 
to the bottom of the channel.  
To properly draw the channel you must first wait for the first two waves to 
form. In an uptrend draw the bottom on the channel on points 0 and 2 and 
the top of the channel on point 1. The top of wave 3 should end when it hits 
the top of the channel. See chart 
When you get to the top of wave 3 then the channel should be adjusted so 
that its top is at 3 and the parallel bottom is at 0 and 2. See chart. 
When the bottom of this channel is broken it signals the end of the uptrend. 
Notice the bottom of the 4th wave should end close to the bottom of the 
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channel. The 5th wave should then start. The price target for the 5th  wave is 
the top of the channel. 
Using the Fan Tool 
This is one of the most important tools in Elliott Wave analysis. This tool can 
be used to find trend corrections and reversals. What this tool does is find 
percentage retracements of the 1st, 2nd and 3rd reactions in a correction 
within an uptrend or downtrend. See the next two charts. 
Using the Spiral Tool 
The Spiral tool can be used to show the ends of the corrections in the 
market. Place center at the beginning of the big wave and expand it out until 
it fits the end of the first wave. These spirals use the golden ratio of 1.618 
and turn left. Spirals not only show a price target, but also a time target. 
However, it is of paramount importance to adjust the scaling of Y- and X-
axis correctly, which needs a lot of experimenting. 
To change the properties of the Spiral, position your mouse pointer exactly 
on the Spiral, press the right mouse button and choose properties.  
Using the Golden Ratio Time Ruler 
Tip: Dragging one of the controls of the TIME RULER and pressing SHIFT 
when releasing it near a top or low, will force the TIME RULER to connect 
exactly to that high or low! 
The TIME RULER can be placed anywhere in the chart with "drag and 
drop". You can find the CHART OBJECT box on top in which you will find 
the TIME RULER button. Move the mouse pointer to the window, click the 
left mouse button on the TIME RULER in the Chart object box, keep the 
mouse button pressed down, and drag the TIME RULER to its correct 
position. Release the mouse button and the TIME RULER will position itself 
on the spot you have indicated.  
If you click on the horizontal line of this time object exactly, you will select 
the object. Two controls will appear, which you can grab and drag to 
reposition the object as well as to drop it on a wave label. If the object is 
selected press DELETE to erase the object.  
The TIME RULER object displays the Golden ratio and facilitates finding 
such time relationships. 
You could for example use the time object to find a date for a new future 
low by connecting lows. The same goes for major highs, but of course then 
you have to connect major highs or try to find clusters by connecting all 
major reversals. 
If you put the origin of the line at the first major low and the1.00 point at the 
second low, you will have a forecast for the following major low at point 1.62 
(which is 38.2% of the length of the beginning of the line to point 1.00) and 
at point 2.62 (which is 61.8% of the before mentioned length). If you 
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experiment with this tool, you may find interesting Fibonacci time clusters, 
that forecast future price action. 
To change the properties of the TIME RULER, position your mouse pointer 
exactly on the TIME RULER, press the right mouse button and choose 
properties.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

149

Conclusion 
The Elliott Wave Theory and application to the markets is one of the most 
important tools that a trader has at his fingertips. It is overlooked and not 
used due to its subjectivity. The rules of the theory must be mastered and 
experience is needed before it can be successfully used for trading 
purposes. Until now there was not software program capable of allowing the 
trader to use the theory in his trading. The ELWAVE program has filled that 
important gap. It has everything in it to successfully a trading program for 
the markets. Put the Elliott Wave theory to use in the markets with the help 
of the ELWAVE program and you should learn to love to analyze and 
successfully the markets. 
Internet Site 
With the purchase of this book you are eligible to access the Elliott Wave 
Masters site. To do this you need the username and password. To obtain 
this just e-mail us at: publisher@tradersworld.com 
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Order Form 
 
Prices for the ELWAVE Program and the Modules  
(prices subject to change)  
Basic:  $255 
Intraday: $315 
Automatic:  $470 
Trading Signals:  $315 
Target Clusters:  $270 
Trial Version: $75 
Update to Basic: $180 
 
Name______________________________________________________ 
 
Company___________________________________________________ 
 
Address____________________________________________________ 
 
City_______________________________State______Zip____________ 
 
Country_____________________________________________________ 
 
Phone___________________________E-mail______________________ 
 
Method of Payment:   ____Check    ____ MC    ____ Visa    ____AMAX 
 
Credit Card No._____________________________________Exp._______ 
 
 
Website: www.tradersworld.com, E-Mail:  publisher@tradersworld.com 
Toll Free:  800-288-4266, Phone: 417-882-9697, Fax: 417-886-5180 
 
Traders World 
2508 W. Grayrock St.  
Springfield, MO 65810 
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